Appendix A provides a list of supplemental documentation for the Spectrum Master features and options. The documentation set is available as PDF files on the Anritsu website.
## Table of Contents

### Chapter 1—General Information

1-1 Introduction .......................... 1-1
   Additional Documentation ................. 1-1
   Contacting Anritsu for Sales and Service 1-3
1-2 Instrument Description ................. 1-3
   Available Models ........................ 1-4
   Available Options ....................... 1-4
1-3 Calibration and Verification .......... 1-5
1-4 Instrument Care and Preventive Maintenance 1-6
   Connector Care .......................... 1-6
   ESD Caution ............................. 1-7
   RF Input Warning ....................... 1-7
   Battery Replacement .................... 1-8
1-5 Secure Environment Workplace .......... 1-9
   Spectrum Master Memory Types ........... 1-9
   Erase All User Files in Internal Memory 1-10
   Recommended Usage in a Secure Environment 1-10

### Chapter 2—Instrument Overview

2-1 Introduction .......................... 2-1
2-2 Turning On the Spectrum Master .......... 2-1
2-3 Instrument Front Panel ................. 2-2
   LED Indicators .......................... 2-2
   Front Panel Keys ....................... 2-3
2-4 Interface Screen ....................... 2-6
   Touch Screen Keys ...................... 2-6
   Symbols and Icons on the Title Bar .......... 2-7
   Symbols and Indicators .................. 2-8
   Display Settings ....................... 2-9
   Touch Screen Calibration ............... 2-10
2-5 Data Entry ............................ 2-12
   Numeric Values ......................... 2-12
   Selection Lists ......................... 2-12
   Text Entry .............................. 2-13
2-6 Mode Selector .......................... 2-14
2-7 Connector Panel ......................... 2-15
2-8 Soft Carrying Case ...................... 2-18
### Table of Contents (Continued)

2-9 Tilt Bail Stand ................................................................. 2-19

**Chapter 3—Quick Start Guide**

3-1 Introduction ................................................................. 3-1
3-2 Measurement Mode Selection ........................................... 3-1
3-3 Spectrum Analyzer ......................................................... 3-2
   - Set the Frequency ...................................................... 3-2
   - Set the Measurement Frequency Bandwidth ....................... 3-3
   - Set the Amplitude ..................................................... 3-3
   - Reference Level Offset for External Loss or External Gain .. 3-4
   - Set the Span .............................................................. 3-4
   - Single Limit Line ...................................................... 3-4
   - Create a Limit Envelope ............................................. 3-5
   - Setting Up Markers ................................................... 3-6
   - Select a Measurement Type ........................................... 3-7
   - External Power On. ..................................................... 3-8

**Chapter 4—File Management**

4-1 Introduction ................................................................. 4-1
4-2 Managing Files .............................................................. 4-1
   - File Types ............................................................... 4-1
   - Save Files ............................................................... 4-2
   - Recall Files ............................................................ 4-5
   - Copy Files ............................................................... 4-6
   - Delete Files ............................................................. 4-7
4-3 File Menu Overview ....................................................... 4-8
4-4 File Menu ..................................................................... 4-9
   - Save Menu ............................................................... 4-10
   - File Type Menu ......................................................... 4-11
   - Save Location Menu .................................................. 4-11
   - Save On... Menu ....................................................... 4-12
   - Recall Menu ............................................................. 4-13
   - Copy Menu .............................................................. 4-14
   - Delete Menu ............................................................. 4-15

**Chapter 5—System Operations**

5-1 Introduction ................................................................. 5-1
5-2 System Menu Overview .................................................. 5-2
Table of Contents (Continued)

5-3  System Menu ......................................................... 5-3
      System Options Menu ........................................... 5-4
      System Options 2/2 Menu ...................................... 5-5
      Power-On Menu .................................................. 5-6
      Display Settings Menu ........................................... 5-7
      Brightness Settings Menu ...................................... 5-8
      Reset Menu ....................................................... 5-9
5-4  Preset Menu .................................................... 5-10
5-5  Self Test ......................................................... 5-10
5-6  Firmware Update ................................................ 5-11

Chapter 6—GPS (Option 31)
6-1  Introduction ..................................................... 6-1
6-2  Activating the GPS Feature .................................... 6-1
6-3  Resetting GPS .................................................... 6-3
6-4  Saving and Recalling Traces with GPS Information ........ 6-3
       Saving Traces with GPS Information ....................... 6-3
       Recalling GPS Information .................................. 6-3
6-5  GPS Menu ......................................................... 6-4

Chapter 7—Bias Tee (Option 10)
7-1  Overview ........................................................... 7-1

Chapter 8—Anritsu Tool Box
8-1  Introduction ...................................................... 8-1
8-2  Software Installation ............................................ 8-1
8-3  Anritsu Software Tool Box ..................................... 8-2
8-4  Software Tools ................................................... 8-3
       Line Sweep Tools (LST) ....................................... 8-3
       Master Software Tools (MST) ................................. 8-3
       easyTest Tools ................................................ 8-4
       easyMap Tools ................................................ 8-4
       Wireless Remote Tools ....................................... 8-4

Chapter 9—Web Remote Control
9-1  Introduction ...................................................... 9-1
9-2  Setup ............................................................... 9-1
       LAN Connection ................................................. 9-1
       Connection to a Wireless Router ............................. 9-2
Table of Contents (Continued)

9-3 Web Remote Control Interface ........................................... 9-3
    User Login ........................................................................ 9-3
    Home Page ....................................................................... 9-4
    Remote Control ................................................................. 9-5
    Capture Screen ................................................................. 9-7
    Capture Trace .................................................................. 9-7
    File List ............................................................................ 9-8
    Device Management (not as Administrator) ......................... 9-8
    Device Management (Administrator) ..................................... 9-10
    Logout ............................................................................. 9-12

Appendix A—Measurement Guides
A-1 Introduction ................................................................. A-1

Appendix B—LAN and DHCP
B-1 Introduction ................................................................. B-1
B-2 LAN Connection ............................................................. B-1
B-3 Ethernet Configuration ................................................... B-1
    Ethernet Menu .............................................................. B-2
    DHCP .............................................................................. B-4
B-4 ipconfig Tool ................................................................. B-5
B-5 Ping Tool ....................................................................... B-6

Appendix C—Glossary of Terms
C-1 Introduction ................................................................. C-1
C-2 Glossary ....................................................................... C-1

Index
Chapter 1 — General Information

1-1 Introduction

The Spectrum Master User Guide is part of a set of manuals that describe all of the instrument functions and their use. This manual covers the instrument overview, system functions and other common features, along with a brief guide to basic measurement concepts and setups. Instrument operations are explained in various document types as listed below.

Additional Documentation

<table>
<thead>
<tr>
<th>Document Part Number</th>
<th>Description (Required Option)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10100-00065</td>
<td>Important Product Information, Compliance and Safety Notices</td>
</tr>
<tr>
<td>10580-00349</td>
<td>Spectrum Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>Spectrum Analyzer</td>
</tr>
<tr>
<td></td>
<td>PIM Hunting</td>
</tr>
<tr>
<td></td>
<td>Interference Analyzer (Option 25)</td>
</tr>
<tr>
<td></td>
<td>Channel Scanner (Option 27)</td>
</tr>
<tr>
<td></td>
<td>Gated Sweep (Option 90)</td>
</tr>
<tr>
<td></td>
<td>Coverage Mapping (Option 431)</td>
</tr>
<tr>
<td></td>
<td>EMF Measurements (Option 444)</td>
</tr>
<tr>
<td></td>
<td>AM/FM/PM Analyzer (Option 509)</td>
</tr>
<tr>
<td>10580-00234</td>
<td>3GPP Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>GSM/GPRS/EDGE Measurements (Option 880)</td>
</tr>
<tr>
<td></td>
<td>* GSM/EDGE RF Measurements (Option 40)</td>
</tr>
<tr>
<td></td>
<td>* GSM/EDGE Demodulation (Option 41)</td>
</tr>
<tr>
<td></td>
<td>W-CDMA/HSPA+ Measurements (Option 881)</td>
</tr>
<tr>
<td></td>
<td>* W-CDMA/HSPA+ RF Measurements (Option 44)</td>
</tr>
<tr>
<td></td>
<td>* W-CDMA/HSPA+ Demodulation (Option 65)</td>
</tr>
<tr>
<td></td>
<td>* W-CDMA/HSPA+ Over-the-Air Measurements (Option 35)</td>
</tr>
<tr>
<td></td>
<td>TD-SCDMA/HSPA+ Measurements (Option 882)</td>
</tr>
<tr>
<td></td>
<td>* TD-SCDMA/HSPA+ Measurements (Option 60)</td>
</tr>
<tr>
<td></td>
<td>* TD-SCDMA/HSPA+ Demodulation (Option 61)</td>
</tr>
<tr>
<td></td>
<td>* TD-SCDMA/HSPA+ Over-the-Air Measurements (Option 38)</td>
</tr>
<tr>
<td></td>
<td>LTE/LTE-A FDD/TDD Measurements (Option 883)</td>
</tr>
<tr>
<td></td>
<td>LTE and TD-LTE Coverage Mapping (included)</td>
</tr>
<tr>
<td></td>
<td>TD-LTE/LTE OTA EMF Measurements (Option 444)</td>
</tr>
<tr>
<td></td>
<td>* LTE/LTE-A RF Measurements (Option 541)</td>
</tr>
<tr>
<td></td>
<td>* LTE/LTE-A Modulation Measurements (Option 542)</td>
</tr>
<tr>
<td></td>
<td>* LTE/LTE-A Over-the-Air Measurements (Option 546)</td>
</tr>
<tr>
<td></td>
<td>* TD-LTE/LTE-A RF Measurements (Option 551)</td>
</tr>
<tr>
<td></td>
<td>* TD-LTE/LTE-A Modulation Measurements (Option 552)</td>
</tr>
<tr>
<td></td>
<td>* TD-LTE/LTE-A Over-the-Air Measurements (Option 556)</td>
</tr>
<tr>
<td></td>
<td>LTE 256QAM Demodulation Measurements (Option 886)</td>
</tr>
<tr>
<td></td>
<td>NB-IoT Measurements (Option 887)</td>
</tr>
<tr>
<td>Document Part Number</td>
<td>Description (Required Option)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>10580-00235</td>
<td>3GPP2 Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>CDMA/EV-DO Measurements (Option 884)</td>
</tr>
<tr>
<td></td>
<td>* CDMA RF Measurements (Option 42)</td>
</tr>
<tr>
<td></td>
<td>* CDMA Demodulation (Option 43)</td>
</tr>
<tr>
<td></td>
<td>* CDMA Over-the-Air Measurements (Option 33)</td>
</tr>
<tr>
<td></td>
<td>* EV-DO RF Measurements (Option 62)</td>
</tr>
<tr>
<td></td>
<td>* EV-DO Demodulation (Option 63)</td>
</tr>
<tr>
<td></td>
<td>* EV-DO Over-the-Air Measurements (Option 34)</td>
</tr>
<tr>
<td>10580-00236</td>
<td>WiMAX Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>WiMAX Fixed/Mobile Measurements (Option 885)</td>
</tr>
<tr>
<td></td>
<td>* Fixed WiMAX RF Measurements (Option 46)</td>
</tr>
<tr>
<td></td>
<td>* Fixed WiMAX Demodulation (Option 47)</td>
</tr>
<tr>
<td></td>
<td>* Mobile WiMAX RF Measurements (Option 66)</td>
</tr>
<tr>
<td></td>
<td>* Mobile WiMAX Demodulation (Option 67)</td>
</tr>
<tr>
<td></td>
<td>* Mobile WiMAX Over-the-Air Measurements (Option 37)</td>
</tr>
<tr>
<td>10580-00237</td>
<td>Digital Video Broadcast Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>ISDB-T Digital Video Measurements (Option 30)</td>
</tr>
<tr>
<td></td>
<td>ISDB-T SFN Measurements (Option 32)</td>
</tr>
<tr>
<td></td>
<td>ISDB-T BER Measurements (Option 79)</td>
</tr>
<tr>
<td></td>
<td>DVB-T/H Digital Video Measurements (Option 64)</td>
</tr>
<tr>
<td></td>
<td>DVB-T/H SFN Measurements (Option 78)</td>
</tr>
<tr>
<td></td>
<td>DVB-T/H BER Measurements (Option 57)</td>
</tr>
<tr>
<td>10580-00240</td>
<td>Power Meter Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>High-Accuracy Power Meter (Option 19)</td>
</tr>
<tr>
<td></td>
<td>Power Meter (Option 29)</td>
</tr>
<tr>
<td>10580-00242</td>
<td>2-Port Transmission Measurement Guide (Option 21)</td>
</tr>
<tr>
<td></td>
<td>Bias-Tee (Option 10)</td>
</tr>
<tr>
<td>10580-00254</td>
<td>Spectrum Master Maintenance Manual</td>
</tr>
<tr>
<td></td>
<td>Maintenance Manual</td>
</tr>
<tr>
<td>10580-00256</td>
<td>SCPI Programming Manual</td>
</tr>
<tr>
<td>10580-00280</td>
<td>PIM Master User Guide</td>
</tr>
<tr>
<td></td>
<td>PIM Analyzer (supported on legacy instruments only)</td>
</tr>
<tr>
<td>10580-00339</td>
<td>E-Series Tracking Generator Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>Tracking Generator (Option 20)</td>
</tr>
<tr>
<td>10580-00415</td>
<td>CPRI LTE RF Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>CPRI LTE RF Measurements (Option 752; requires Option 759)</td>
</tr>
<tr>
<td></td>
<td>* Option 751 (obsolete) is functionally identical to the combined Options 752 and 759</td>
</tr>
<tr>
<td>10580-00434</td>
<td>OBSAI LTE RF Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>OBSAI LTE RF Measurements (Option 753; requires Option 759)</td>
</tr>
<tr>
<td>10580-00455</td>
<td>EMF Measurement Guide (Option 444)</td>
</tr>
<tr>
<td>11410-00511</td>
<td>Spectrum Master Technical Data Sheet</td>
</tr>
<tr>
<td></td>
<td>Performance Specifications, Instrument Options and Accessories</td>
</tr>
</tbody>
</table>

* Indicates the option is obsolete.
Read the Handheld Instruments Product Information, Compliance, and Safety Guide (PN: 10100-00065) for important safety, legal, and regulatory notices before operating the equipment. For additional information and literature covering your product, visit the product page of your instrument and select the Library tab:


**Contacting Anritsu for Sales and Service**

To contact Anritsu, visit the following URL and select the services in your region: [http://www.anritsu.com/contact-us](http://www.anritsu.com/contact-us).

### 1-2 Instrument Description

The Spectrum Master MS2712E and MS2713E are integrated multi-functional test instruments that eliminate the need to carry and learn multiple test sets. The Spectrum Master can be configured to include: spectrum analyzer, interference analyzer with interference mapping capabilities, coverage mapping, channel scanner, gated sweep, tracking generator, power meter, high accuracy power meter, and AM/FM/PM analyzer. In addition, the Spectrum Master can be configured to include 3GPP, 3GPP2, IEEE 802.16, ISDB-T, and PIM analyzer. A GPS receiver can be added to both the MS2712E and MS2713E Spectrum Master models.

The bright 8.4 in TFT color display provides easy viewing in a variety of lighting conditions. All Spectrum Master models are equipped with a Li-Ion battery delivering more than three hours of battery life.

The combination of a touch screen and keypad enables users to navigate menus with the touch screen and enter numbers with the keypad.

The internal memory is large enough to store approximately 2,000 traces or setups. Measurements and setups can also be stored in a USB flash drive or transferred to a PC using the included USB cable.

| Note | Not all after-market USB drives are compatible with the MS2712E/13E. Many drives come with a second partition that contains proprietary firmware. This partition must be removed. Only one partition is allowed. Refer to the individual manufacturer for instructions on how to remove it. You may also try reformatting a drive that contains a single partition using FAT32 format. |
Available Models

Table 1-1 lists the Spectrum Master models described in this User Guide.

<table>
<thead>
<tr>
<th>Model</th>
<th>Frequency Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS2712E</td>
<td>Spectrum Analyzer, 9 kHz to 4 GHz</td>
</tr>
<tr>
<td>MS2713E</td>
<td>Spectrum Analyzer, 9 kHz to 6 GHz</td>
</tr>
</tbody>
</table>

Available Options

Available options for the Spectrum Master are shown in Table 1-2.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS2712E-0009</td>
<td>MS2713E-0009 20 MHz Bandwidth Demod</td>
</tr>
<tr>
<td>MS2712E-0010</td>
<td>MS2713E-0010 Bias-Tee</td>
</tr>
<tr>
<td>MS2712E-0019</td>
<td>MS2713E-0019 High-Accuracy Power Meter (requires External Power Sensor)</td>
</tr>
<tr>
<td>MS2712E-0020</td>
<td>MS2713E-0020 Tracking Generator</td>
</tr>
<tr>
<td>MS2712E-0025</td>
<td>MS2713E-0025 Interference Analyzer (Option 31 recommended)</td>
</tr>
<tr>
<td>MS2712E-0027</td>
<td>MS2713E-0027 Channel Scanner</td>
</tr>
<tr>
<td>MS2712E-0029</td>
<td>MS2713E-0029 Power Meter</td>
</tr>
<tr>
<td>MS2712E-0030</td>
<td>MS2713E-0030 ISDB-T Digital Video Measurements(1)</td>
</tr>
<tr>
<td>MS2712E-0031</td>
<td>MS2713E-0031 GPS Receiver (requires GPS Antenna)</td>
</tr>
<tr>
<td>MS2712E-0032</td>
<td>MS2713E-0032 ISDB-T SFN Measurements(1)</td>
</tr>
<tr>
<td>MS2712E-0057</td>
<td>MS2713E-0057 DVB-T/H BER Measurements (requires Option 64; cannot be ordered with Option 759)</td>
</tr>
<tr>
<td>MS2712E-0064</td>
<td>MS2713E-0064 DVB-T/H Digital Video Measurements(1)</td>
</tr>
<tr>
<td>MS2712E-0078</td>
<td>MS2713E-0078 DVB-T/H SFN Measurements(1)</td>
</tr>
<tr>
<td>MS2712E-0079</td>
<td>MS2713E-0079 ISDB-T BER Measurements (requires Option 30; cannot be ordered with Option 759)</td>
</tr>
<tr>
<td>MS2712E-0090</td>
<td>MS2713E-0090 Gated Sweep</td>
</tr>
<tr>
<td>MS2712E-0098</td>
<td>MS2713E-0098 Standard Calibration to ISO17025 and ANSI/NCSL Z540-1. Includes calibration certificate.</td>
</tr>
<tr>
<td>MS2712E-0099</td>
<td>MS2713E-0099 Premium Calibration to ISO17025 and ANSI/NCSL Z540-1. Includes calibration certificate, test report, and uncertainty data.</td>
</tr>
<tr>
<td>MS2712E-0431</td>
<td>MS2713E-0431 Coverage Mapping (requires Option 31)</td>
</tr>
<tr>
<td>MS2712E-0444</td>
<td>MS2713E-0444 EMF Measurements (requires Anritsu Isotropic Antenna)</td>
</tr>
<tr>
<td>MS2712E-0509</td>
<td>MS2713E-0509 AM/FM/PM Analyzer</td>
</tr>
<tr>
<td>MS2712E-0752</td>
<td>MS2713E-0752 CPRI LTE RF Measurements (requires Option 759)</td>
</tr>
</tbody>
</table>
1-3 Calibration and Verification

Anritsu recommends an annual calibration and performance verification of the Spectrum Master by local Anritsu service centers. The Spectrum Master is self-calibrating and there are no field-adjustable components. Contact information for Anritsu Service Centers is available at http://www.anritsu.com/contact-us.

Table 1-2. Available Options (Sheet 2 of 2)

<table>
<thead>
<tr>
<th>MS2712E</th>
<th>MS2713E</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS2712E-0753</td>
<td>MS2713E-0753</td>
<td>OBSAI LTE RF Measurements (requires Option 759)</td>
</tr>
<tr>
<td>MS2712E-0759</td>
<td>MS2713E-0759</td>
<td>RF over Fiber Hardware (requires Option 752 or 753; cannot be ordered with Option 57 or 79)</td>
</tr>
<tr>
<td>MS2712E-0880</td>
<td>MS2713E-0880</td>
<td>GSM/GPRS/EDGE Measurements(1)</td>
</tr>
<tr>
<td>MS2712E-0881</td>
<td>MS2713E-0881</td>
<td>W-CDMA/HSPA+ Measurements(1) (Option 31 recommended)</td>
</tr>
<tr>
<td>MS2712E-0882</td>
<td>MS2713E-0882</td>
<td>TD-SCDMA/HSPA+ Measurements(1) (requires Option 31 for full functionality)</td>
</tr>
<tr>
<td>MS2712E-0883</td>
<td>MS2713E-0883</td>
<td>LTE/LTE-A FDD/TDD Measurements(1) (requires Option 31 for full functionality)</td>
</tr>
<tr>
<td>MS2712E-0884</td>
<td>MS2713E-0884</td>
<td>CDMA/EV-DO Measurements(1) (requires Option 31 for full functionality)</td>
</tr>
<tr>
<td>MS2712E-0885</td>
<td>MS2713E-0885</td>
<td>WiMAX Fixed/Mobile Measurements(1) (requires Option 31 for full functionality)</td>
</tr>
<tr>
<td>MS2712E-0886</td>
<td>MS2713E-0886</td>
<td>LTE 256QAM Demodulation Measurements (requires Option 883 or Option 552(2))</td>
</tr>
<tr>
<td>MS2712E-0887</td>
<td>MS2713E-0887</td>
<td>NB-IoT Measurements(1)</td>
</tr>
</tbody>
</table>

1. Requires Option 9.
2. This option is obsolete.
1-4 Instrument Care and Preventive Maintenance

Instrument care and preventive maintenance consist of cleaning the unit and inspecting and cleaning the RF connectors and all accessories. Clean the instrument with a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether the connectors are undamaged, gauge the connectors to confirm that the dimensions are correct. Visually inspect the test port cable(s). The test port cable should be uniform in appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors can limit the accuracy of your measurements. Damaged connectors can harm the instrument.

Connection of cables carrying an electrostatic potential, excess power, or excess voltage can damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically into the contact fingers of the female connector.
2. Push connectors straight together. Do not twist or screw them together. A slight resistance can usually be felt as the center conductors mate.
3. To tighten, turn the connector nut, not the connector body. Major damage can occur to the center conductor and to the outer conductor if the connector body is twisted.
4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or 45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order to assure consistent torque. Use an open-end wrench to keep the connector body from turning while tightening with the torque wrench.

Do not over-torque the connector.

Disconnecting Procedure

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning while loosening with a second wrench.
2. Complete the disconnection by hand, turning only the connector nut.
3. Pull the connectors straight apart without twisting or bending.
ESD Caution

The Spectrum Master, like other high performance instruments, is susceptible to electrostatic discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which (if allowed to discharge by connecting directly to the instrument without discharging the static charge) may damage the Spectrum Master input circuitry. Instrument operators must be aware of the potential for ESD damage and take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 (EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, equipment, and practices. Because these apply to the Spectrum Master, it is recommended that any static charges that may be present be dissipated before connecting coaxial cables or antennas to the Spectrum Master. This may be as simple as temporarily attaching a short or load device to the cable or antenna prior to attaching to the Spectrum Master. It is important to remember that the operator may also carry a static charge that can cause damage. Following the practices outlined in the above standards will ensure a safe environment for both personnel and equipment.

RF Input Warning

The Anritsu Spectrum Master is a sensitive measuring instrument designed to measure low power levels. Avoid damaging this sensitive circuitry by observing the maximum input levels printed on the instrument connector labeling and specified in the product technical data sheet.

Typical maximum input is +33 dBm (±50 VDC) and could be less if additional features, such as a preamplifier, are in use. Be sure to review the product technical data sheet or Anritsu website for recommended components and accessories that can help you protect your instrument. These include a variety of adapters, attenuators, filters, and RF detection accessories.
Battery Replacement

The battery can be replaced without the use of tools. The battery compartment is located on the lower left side of the instrument (when you are facing the measurement display). To remove the battery:

1. Slide the catch toward the bottom of the instrument.
2. Pull the top of the door away from the unit.
3. Lift out the battery door.
4. Pull straight out on the lanyard to remove the battery pack from the instrument.

**Note** When inserting the battery, the battery label should face the back of the instrument and the end where the battery contacts are located slides in first. If the battery door does not latch closed, the battery may be inserted incorrectly.

The battery that is supplied with the Spectrum Master may need charging before use. The battery can be charged while it is installed in the Spectrum Master by using the AC-DC Adapter, or outside the Spectrum Master with the optional Dual Battery Charger. Refer to “Symbols and Indicators” on page 2-8 for a description of battery symbols.

**Note** Use only Anritsu Company approved batteries, adapters, and chargers with this instrument. Anritsu recommends removing the battery for long-term storage of the instrument.
Caution

When using the Automotive Power Adapter, always verify that the supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or debris. If the adapter plug becomes hot to the touch during operation, discontinue use immediately.

1-5 Secure Environment Workplace

This section details the types of memory in the Spectrum Master, how to delete stored user files in internal memory, and recommended usage in a secure environment workplace.

Spectrum Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM memory. The instrument does not have a hard disk drive or any other type of volatile or non-volatile memory.

**Disk-On-A-Chip (DOC):** DOC is used for storage of instrument firmware, factory calibration information, user measurements, setups, and .jpg screen images. User information stored on the DOC is erased by the master reset process described below.

**EEPROM:** This memory stores the model number, serial number, and calibration data for the instrument. Also stored here are the user-set operating parameters such as frequency range. During the master reset process, all operating parameters stored in the EEPROM are set to standard factory default values.

**RAM Memory:** This is volatile memory used to store parameters needed for the normal operation of the instrument along with current measurements. This memory is reset whenever the instrument is restarted.

**External USB Flash Drive (not included with the instrument):** This memory may be selected as the destination for saved measurements and setups for the instrument. The user can also copy the contents of the internal disk-on-chip memory to the external flash memory for storage or data transfer. The external Flash USB can be reformatted or sanitized using software on a PC.

Refer to Chapter 4, “File Management” for additional information on saving and copying files to the USB flash drive.
Erase All User Files in Internal Memory

Perform a Master Reset:

1. Turn the instrument on.
2. Press the Shift button, then the System (8) button.
3. Press the System Options submenu key.
4. Press the Reset key, then the Master Reset key.
   A message box will be displayed to warn the user that all settings will be returned to factory default values and all user files will be deleted. This is a standard file deletion and does not involve overwriting existing information.
5. Press the ENTER button to complete the master reset.
6. The instrument will reboot and the reset is complete.

Recommended Usage in a Secure Environment

Set the Spectrum Master to save files to the external USB Flash drive:

1. Attach the external Flash drive and turn the instrument on.
2. Press the Shift button, then the File (7) button.
3. Press the Save submenu key.
4. Press the Change Save Location submenu key, then select the USB drive with the rotary knob, Up/Down arrow keys, or the touch screen.
5. Press the Set Location submenu key.

The external USB drive is now the default location for saving files.

| Note | Not all USB drives are compatible with the instrument. Many drives come with a second partition that contains proprietary firmware. This partition must be removed. Only one partition is allowed. Refer to the individual manufacturer for instructions on how to remove it. Some drives can be made to work by reformatting them using the FAT32 format. |
Chapter 2 — Instrument Overview

2-1 Introduction

This chapter provides an overview of the Anritsu Spectrum Master. It describes the instrument front panel, touch screen display, and the connector panel. For detailed information on the instrument’s test and measurement functions, refer to one of the Anritsu user documents listed in Appendix A, “Measurement Guides”.

2-2 Turning On the Spectrum Master

The Anritsu Spectrum Master is capable of approximately three hours of continuous operation from a fully charged, field-replaceable battery (refer to “Battery Replacement” on page 1-8). The Spectrum Master can also be operated from a 12 VDC source (which will simultaneously charge the battery). This can be achieved with either the Anritsu AC-DC Adapter or the Automotive Power Adapter. Both items are included as standard accessories with the Spectrum Master. Refer to the instrument Technical Data Sheet.

Caution

When using the Automotive Power Adapter, always verify that the supply is rated for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or debris. If the adapter plug becomes hot to the touch during operation, discontinue use immediately.

To turn on the Spectrum Master, press the green On/Off button on the front panel (see Figure 2-1 on page 2-2).

The Spectrum Master takes approximately 60 seconds to complete power-up and to load the application software. At the completion of this process, the instrument is ready for use.

Note

Keep the fan inlet and exhaust ports clear of obstructions at all times for proper ventilation and cooling of the instrument.
2-3 Instrument Front Panel

The Spectrum Master uses a touch screen and keypad for data input. See Figure 2-1. The five bottom menu keys and up to eight submenu keys on the right side of the display are touch screen keys. The menu and submenu keys vary depending on the current measurement mode, installed options, and instrument function selected.

**Figure 2-1. Spectrum Master Front Panel and Interface Screen**

**LED Indicators**

**Power LED**

The Power LED is located on the left of the On/Off button. The LED is solid green when the instrument is on, and blinks slowly when the unit is off but is connected to an external power source.

**Charge LED**

The Charge LED is located on the right of the On/Off button. The LED blinks slowly when the battery is charging and is solid green when the battery is fully charged.
Front Panel Keys

The numeric keypad, rotary knob, and the four arrow keys can all be used to change the value of the currently selected parameter.

Numeric Keypad

Keys 0 through 9 are used for numeric input, with an alternate function printed in blue above each of the keys. Press the Shift key, then a numeric key, to access the instrument menu or function indicated by the key label.

Some of the alternate functions associated with the numeric keypad are not available in all measurement modes. Refer to the Measurement Guides listed in Appendix A.

Shift Key

Pressing the Shift key followed by a number key executes the function that is indicated in blue above the number key. When the Shift key is active, its icon is displayed at the far right of the title bar, above the sweep window.

Figure 2-2. Shift Key Icon in Title Bar

Esc Key

Press this key to cancel the parameter change being made and exit the current menu function, if applicable.

Arrow Keys

The four arrow keys are used to scroll through a list and highlight the item you wish to select, or to change the value of the currently selected parameter. The arrow keys can also be used to move markers. The rotary knob performs similar functions.

Enter Key

Press this key to apply a parameter value or instrument setting you have entered, or to select a highlighted item from a list.

Rotary Knob

Turn the rotary knob to change numerical values, scroll through selectable items in a list, or to move markers. Values or items may be within a dialog box or an edit window.
**Menu Key**

The **Menu** key displays a grid of shortcut icons for installed measurement modes and user-selected menus and setup files. See Figure 2-3. Press one of the icons in the top three rows to switch to the corresponding application. These icons are system-generated and cannot be moved or deleted.

An alternative to the **Menu** key is to press **Shift**, then the **Mode (9)** key to display the Mode Selector list box. Refer to “Mode Selector” on page 2-14.

---

**Figure 2-3.** Menu Key Screen

**Note**  
Shortcut icons displayed in the top rows of the Menu screen vary with the instrument model, firmware version, and installed options. Help for the Menu screen is available by pressing the icon in the lower-right corner of the display.
User-Created Shortcuts

To create a shortcut to any submenu key or main menu key, press and hold the key until a grid appears, showing the open locations on the Menu screen where you can place the new shortcut. Press one of the cells in the displayed grid to place the shortcut. See Figure 2-4.

Figure 2-4. Placement Grid for User-Created Shortcuts

To create a shortcut to a setup file (.stp), press Recall under the File menu, then press and hold the desired file name until a grid is displayed. Select the display location of the new shortcut as described above.

User-defined shortcuts remain on the Menu screen until deleted. To delete or move a shortcut icon, press the Menu key, then press and hold the shortcut until the Customize Button dialog appears. See Figure 2-5. Press the appropriate button to delete or move the shortcut icon.

Figure 2-5. Customize Button Dialog

Press Esc to close the dialog without deleting or moving the shortcut. Also use Esc to exit the Menu screen.
2-4 Interface Screen

Figure 2-6 illustrates the Spectrum Master interface screen in Spectrum Analyzer mode, with touch screen menu keys, title bar, and measurement settings and results around the graph area, or sweep window.

Touch Screen Keys

Main Menu Touch Screen Keys

There are five main menu keys horizontally arranged along the bottom of the interface screen. These keys give access to the instrument’s test and measurement functions, which are documented in the applicable Measurement Guide. Refer to Appendix A, “Measurement Guides”.

Note

Many of the measurement settings displayed to the left and the top of the sweep window are actually touch screen shortcuts that you can press to bring up the corresponding menu.
Different operation or measurement modes may display different main menu keys. To switch to another mode, press the **Menu** key, or press **Shift** followed by the **Mode** (9) key.

**Note**
The instrument model and installed options determine what measurement modes are available. Refer to Table 1-1 and Table 1-2 on page 1-4.

**Submenu Touch Screen Keys**

Most of the instrument setup, control, and measurement functions are performed through the use of the submenu keys along the right side of the display. The key labels change as measurement settings and instrument setup parameters change. The current submenu title is displayed at the top of the submenu key block, which consists of up to eight touch screen keys. See Figure 2-6 on page 2-6.

**Symbols and Icons on the Title Bar**

The instrument title bar displays the system date and time. When GPS is on and is tracking satellites, its icon is followed by latitude and longitude coordinates.

Press the storage icon to open the touch screen keyboard for saving measurements, setups, limit lines, or screen display JPEG files. This shortcut to the “Save Menu” on page 4-10 is equivalent to pressing **Shift** and **File** (7), then **Save**. Refer to “Save Dialog Box” on page 4-3.

Press the camera icon to save a JPEG image of the current screen display.

The battery symbol indicates the charge remaining in the battery. The colored section inside the symbol changes size and color with the charge level. See Table 2-1 on page 2-8. The Battery Charge LED (adjacent to the On/Off button) flashes when the battery is charging, and remains on steady when the battery is fully charged.

**Caution**
Use only Anritsu-approved batteries, adapters, and chargers with this instrument. Anritsu Company recommends removing the battery for long-term storage of the instrument.

The **Shift** icon is displayed after the **Shift** key is pressed, and it remains displayed until another button is pressed.
Symbols and Indicators

The following symbols, icons, and indicators convey the instrument status or condition on the display. The colors shown here are in the standard or default display mode.

Table 2-1. Symbols and Icons

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green Battery" /></td>
<td><strong>Green</strong>: Battery is 30% to 100% charged.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow Battery" /></td>
<td><strong>Yellow</strong>: Battery is 10% to 30% charged.</td>
</tr>
<tr>
<td><img src="image" alt="Red Battery" /></td>
<td><strong>Red</strong>: Battery is 0% to 10% charged.</td>
</tr>
<tr>
<td><img src="image" alt="Green with Black Plug body" /></td>
<td><strong>Green with Black Plug body</strong>: Battery is fully charged and external power is applied.</td>
</tr>
<tr>
<td><img src="image" alt="Lightning Bolt" /></td>
<td><strong>Lightning Bolt</strong>: Battery is being charged (any color symbol).</td>
</tr>
<tr>
<td><img src="image" alt="Red Plug body" /></td>
<td><strong>Red Plug body</strong>: External power is applied, and no battery is installed, or battery has lost communications with the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Storage Icon" /></td>
<td><strong>Storage Icon</strong>: Tap the floppy disk icon to display the Save screen and menu.</td>
</tr>
<tr>
<td><img src="image" alt="Camera Icon" /></td>
<td><strong>Camera Icon</strong>: Saves a JPEG image of the current screen display.</td>
</tr>
<tr>
<td><img src="image" alt="Shift Key Icon" /></td>
<td><strong>Shift Key Icon</strong>: This icon is displayed between the battery symbol and the submenu keys after the Shift key has been pressed, and until another key is pressed.</td>
</tr>
<tr>
<td><img src="image" alt="GPS Icon" /></td>
<td><strong>GPS Icon</strong>: This icon is displayed right after the date and time when GPS is available. Refer to Chapter 6, “GPS (Option 31)” for details.</td>
</tr>
<tr>
<td><img src="image" alt="Power Button with Power LED and Charge LED" /></td>
<td><strong>Power Button with Power LED and Charge LED</strong>: This is a physical button with LED indicators. It is located near the numeric keypad.</td>
</tr>
</tbody>
</table>
Display Settings

The Display Settings submenu lets you adjust the screen brightness level and control the auto-dimming function. Refer to “Brightness Settings Menu” on page 5-8.

You can also turn off the display entirely, as described in “Display Settings Menu” on page 5-7. To turn the display back on, press any key (except the Power button) three times in rapid succession.

In addition to the default display colors shown in Figure 2-6 on page 2-6, you can select different color schemes to suit the ambient lighting conditions. See Figure 2-8. Some color settings may not be available in all measurement modes.

- **Black on White** — used for printing and viewing in broad daylight conditions
- **Night Vision** — optimized for nighttime viewing
- **High Contrast** — used in challenging viewing conditions
- **Color on White** — used for printing and viewing in broad daylight conditions

![Figure 2-8. Spectrum Master Display Color Settings](image-url)
Touch Screen Calibration

Calibration optimizes the response of touch input. It is recommended if the instrument does not respond as expected when you press the touch screen.

The Calibrate Touch Screen submenu key is in the “System Menu” on page 5-3. When pressed, a message box is displayed with instructions for calibration. See Figure 2-9. Press Enter to begin calibration, or press Esc to cancel. Alternatively, you can press 1 while the message box is displayed to use the arrow keys for navigation. Refer to “Disable Touch Screen to Use Arrow Navigation”.

During calibration, press the crosshairs in sequence as they appear on the screen. The process takes less than one minute.

Calibrate Touch Screen Shortcut

Another way to access touch screen calibration is to press Shift, then 0 (zero). This displays the touch screen calibration message box shown in Figure 2-9. The shortcut can be used if your touch inputs do not correspond to the appropriate locations on the screen to such an extent that you cannot access the Calibrate Touch Screen submenu key.

Disable Touch Screen to Use Arrow Navigation

If the touch screen is not functioning, you can use Arrow Navigation to simulate pressing the touch screen main menu keys and submenu keys. From the touch screen calibration message box (see Figure 2-9), press 1 to display the arrow navigation message box, illustrated in Figure 2-10. Press 1 again to enter the arrow navigation mode, or press Esc to cancel.

In arrow navigation mode, a red border highlights the currently selected key (see Figure 2-11 on page 2-11). Use the arrow keys to move the red selection box, then press the Menu key to activate the highlighted key. Only the main menu keys and submenu keys can be activated using Arrow Navigation. This feature does not move the red selection box into other areas of the touch screen, like the display title bar, sweep window, or the instrument settings area on the left.
To save a measurement in arrow navigation mode, press Shift then File (7). Use the arrow keys to move the red selection box to the Save Measurement As submenu key. This submenu key must be used because the arrow navigation mode cannot be used to change data in popup windows in the measurement display. File names are determined by the current setting of the Save Measurement As submenu key. Refer to “Save Measurement As” on page 4-9.

You can save a JPEG image of the current display screen by pressing Shift, followed by Decimal, then +/- . The JPEG image shows screen data, but does not contain the additional measurement information that accompanies a saved measurement in a *.spa measurement file.

To return to normal touch entry mode, reboot the instrument (turn power Off, then On). If your touch screen has been damaged, refer to “Contacting Anritsu for Sales and Service” on page 1-3.

Figure 2-11. Arrow Navigation Example
2-5 Data Entry

User input can be in the form of numeric values for instrument or measurement settings, selected values from a preset list, or alphanumeric text when entering file names, for example. To view or change a parameter value, access the appropriate submenu by pressing one of the five main menu keys along the bottom of the interface screen, then navigating through the touch screen submenus.

Other instrument functions are accessible from the numeric keypad, when used in combination with the Shift key. Refer to “Numeric Keypad” on page 2-3. Some of the parameter settings displayed on the left of the interface screen or under the title bar are touch screen shortcuts to related submenus.

Depending on the measurement mode, refer to the associated Measurement Guide listed in Appendix A for a description of available menus and submenus.

Numeric Values

To modify a numeric parameter setting that is displayed on a submenu touch screen key, press the key to make it active. The display color of the currently set value changes to red. Use the rotary knob, arrow keys, or the numeric keypad to change the value. When entering a value from the keypad, the submenu typically shows the selectable units. Press the desired unit or press Enter to complete the entry.

Selection Lists

Some parameters and instrument functions are selectable from a pop-up list. These list boxes display the available selections, and value limits if applicable. Use the arrow keys or the rotary knob to scroll through the list and highlight the desired entry. You can also use the touch screen to make your selection.

To apply the selection, press Enter. To exit the selection list without making a change, press the Escape (Esc) key.
Text Entry

When an instrument function requires you to enter text, such as a name for a measurement or setup file you wish to save, a touch screen keyboard is displayed. See Figure 2-12. Digits can be entered using the touch screen keyboard or the front panel keypad. The left and right arrow keys move the insertion point in the file name edit box.

Refer to “Save Dialog Box” on page 4-3 for information on saving files.

![Figure 2-12. Touch Screen Keyboard](image-url)
2-6 Mode Selector

To change to another operation or measurement mode, press Shift, then the Mode (9) key to display the Mode Selector list box, illustrated in Figure 2-13. Use the directional arrow keys or the rotary knob to highlight the desired mode, then press Enter to switch to the selected application. The measurement modes available for selection depend on the options that are installed and activated on your instrument.

An alternate method of selecting a measurement mode is through the use of the “Menu Key” on page 2-4.

Figure 2-13. Mode Selector List Box
The Spectrum Master connector panel is illustrated in Figure 2-14.

Figure 2-14. Spectrum Master Connector Panel

1. External Reference In
2. External Trigger In
3. Analyzer/RF In (Type N)
4. GPS Type SMA (Option 31)
5. USB Mini-B
6. RJ45 Ethernet Connector
7. External Power
8. USB Type A
9. Headset jack
10. SFP Optical Module Connector (Option 759; cannot be ordered with Option 57 or 79)
11. DVB ASI Out Connector (Options 57 and 79; cannot be ordered with Option 759)
12. Generator/RF Out Type N (Option 20)

External Reference In

The External Reference In port is a 50 Ω BNC female connector that provides for input of an external frequency reference. Refer to your Technical Data Sheet for valid frequencies. To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC connector.
External Trigger In
A TTL signal that is applied to the External Trigger female BNC input connector causes a single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is displayed until the next trigger signal arrives.

Analyzer/RF In
This is a 50 Ω Type-N female connector. The maximum input is +33 dBm at ±50 VDC.

USB Interface – Mini-B
The USB 2.0 Mini-B connector can be used to connect the Spectrum Master directly to a PC. The first time the Spectrum Master is connected to a PC, the normal USB device detection by the computer operating system will take place.

| Note | For proper detection, the applicable Anritsu Software Tool should be installed on the PC prior to connecting the Spectrum Master to the USB port. |

GPS Antenna Connector (Option 31)
The GPS antenna connection on the Spectrum Master is type SMA-female. GPS function is described in Chapter 6, “GPS (Option 31)”. To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the SMA connector. Do not over-tighten the connector. The recommended torque is 8 lbf·in (0.9 N·m or 90 N·cm).

External Power
This is a 2.1 mm by 5.5 mm barrel connector, 12.5 to 15 VDC, < 4.0 A. The external power connector is used to power the unit and for battery charging. A green blinking LED near the Power button indicates that the instrument battery is being charged by the external charging unit. The indicator is a steady green when the battery is fully charged.

| Warning | When using the AC-DC Adapter, always use a three-wire power cable that is connected to a three-wire power line outlet. If power is supplied without grounding the equipment in this manner, the user is at risk of receiving a severe or fatal electric shock. |

Refer to “External Power On” on page 3-8 and “Power-On Menu” on page 5-6 when controlling the instrument via external power.

USB Interface – Type A
The Spectrum Master has two Type A USB connectors that accept USB Flash Memory devices for storing measurements, setup data, and screen images.
Headset Jack

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing and troubleshooting wireless communication systems. The jack accepts a 3.5 mm 3-wire miniature phone plug such as those commonly used with cellular telephones.

Digital Signal Output (DVB ASI Out) BNC Connector (Options 57, 79)

The digital signal output, BNC female connector is unique to the Bit Error Rate (BER) options (Option 57 and Option 79) and is present only when one or both of these options are installed. The Digital Television Signal Analyzer options operations are described in the Digital Television Signal Analyzer Measurement Guide (refer to Appendix A).

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC connector. Do not over-tighten the connector.

The DVB-ASI function produces MPEG-TS data output during a BER measurement. This output can be connected to MPEG-TS analysis equipment to monitor video errors or can be connected via appropriate ASI to USB demultiplexing and decoding accessories for channel identification and monitoring purposes.

LAN Connection

The RJ-45 connector is used to connect the Spectrum Master to a local area network or directly to a PC with an Ethernet cable. Integrated into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to show that LAN traffic is present. For more information on the LAN connection, Ethernet connection, and DHCP, refer to Chapter 9 and Appendix B.

Optical SFP (Option 759)

The optical transceiver port is used to connect the instrument to the fiber optic CPRI or OBSAI link between a Radio Frequency Module (RFM) and a Base Band Module (BBM). This SFP port is present only when Option 759 (RF over Fiber hardware) is installed. Refer to the instrument’s Technical Data Sheet for transceiver part numbers and specifications.

| Note | Option 759 requires either Option 752 (CPRI LTE RF Measurements) or Option 753 (OBSAI LTE RF Measurements). The combination of Option 759 and Option 752 is functionally identical to obsolete Option 751. |

Generator/RF Out (Option 20)

RF output, 50 Ω impedance, for tracking generator (Option 20). The maximum input is +23 dBm at ±50 VDC.
2-8  Soft Carrying Case

The Spectrum Master can be operated while in the soft carrying case. On the back of the case is a large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front panel of the case. When closed, the front panel supports the shape of the case while you are inserting the Spectrum Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully closed and laying flat.

3. Open the zipperered back of the case.

4. Insert the instrument face down into the case, take care that the connectors are properly situated in the case top opening. You may find it easier to insert the connectors first, then pull the corners over the bottom of the Spectrum Master.

5. Close the back panel and zipper to secure the Spectrum Master.

**Note**
The soft case has two zippers near the back. The zipper closer to the front of the case opens to install and remove the instrument. The zipper closer to the back of the case opens an adjustable support panel that can be used to provide support for improved stability and air flow while the instrument is in the case. This support panel also contains the storage pouch.

![Instrument Inserted into the Soft Carrying Case](image)

**Figure 2-15.** Instrument Inserted into the Soft Carrying Case
The soft carrying case includes a detachable shoulder strap, which can be connected to the D-rings of the case.

**Caution**
The soft case has panel openings for the fan inlet and exhaust ports. Do not block the air flow through the panels when the unit is operating.

### 2-9 Tilt Bail Stand

A Tilt Bail is attached to the back of the Spectrum Master for desktop operation. The tilt bail provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the bottom of the bail towards the back of the instrument until it attaches to the Spectrum Master.

**Note**
Do not use the tilt bail while the instrument is in the soft case. The soft case has an adjustable support panel in the back zipper.

---

**Figure 2-16.** Tilt Bail Extended
Chapter 3 — Quick Start Guide

3-1 Introduction

This chapter provides a brief overview of basic measurement setups. For detailed descriptions of measurement functions and settings, refer to the appropriate Measurement Guide as listed in Appendix A.

3-2 Measurement Mode Selection

Press the Menu key, then press the shortcut icon for the desired application, or measurement mode. See Figure 3-1. Alternatively, you can press Shift followed by the Mode (9) key, then select the measurement mode from the Mode Selector list box.

![Menu Screen - Shortcuts to Installed Applications](image)

Figure 3-1. Menu Screen - Shortcuts to Installed Applications

**Note** The application shortcuts displayed in the top rows of the Menu screen will vary depending on the firmware and options installed on the instrument.
3-3 Spectrum Analyzer

Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement Mode Selection” on page 3-1.

Set the Frequency

Set Start and Stop Frequencies

1. Press the Freq main menu key.
2. Press the Start Freq submenu key.
3. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.
4. Press the Stop Freq submenu key.
5. Enter the desired stop frequency.

Set the Center Frequency

1. Press the Freq main menu key.
2. Press the Center Freq submenu key.
3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard

1. Press the Freq main menu key.
3. Highlight a signal standard and press Enter to select.
4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Frequency Offset

1. Press the Freq main menu key.
2. Press the Step Size & Other submenu key.
3. Press the Freq Offset submenu key and enter the desired frequency offset using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the
appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.

4. Offset will be displayed at the bottom of the screen. The Center Freq, Start Freq, and Stop Freq keys will also indicate that a frequency offset has been turned on.

5. Set the Freq Offset to 0 Hz to remove the frequency offset.

Note: The Freq Offset will affect the displayed values of frequencies, Markers and Limits. The currently frequency offset value is displayed on the Freq Offset submenu key, located under the Freq main menu > Step Size & Offset submenu.

Set the Measurement Frequency Bandwidth

1. Press the BW main menu key to display the BW menu.
   - Press the RBW and/or the VBW submenu key to manually change the values.
   - Set RBW and VBW automatically by pressing the Auto RBW submenu key or the Auto VBW submenu key.
2. Press the RBW/VBW submenu key to change the resolution bandwidth and video bandwidth ratio.
3. Press the Span/RBW submenu key to change the span width to resolution bandwidth ratio.

Set the Amplitude

Press the Amplitude main menu key to display the Amplitude menu.

Set Amplitude Reference Level and Scale

1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the keypad to change the reference level. Press Enter to set the reference level value.
2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. Press the Auto Atten submenu key to set an optimal reference level based on the measured signal.
2. Press the Scale submenu key.
3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. Press Enter to set. The y-axis scale is automatically renumbered.
Reference Level Offset for External Loss or External Gain

To obtain accurate measurements, compensate for any external attenuation or gain by using the RL Offset submenu. The compensation factor is in dB. External attenuation can be created by using an external cable or an external high power attenuator, external gain is typically from an amplifier.

To adjust the reference level for either gain or loss, press the RL Offset submenu key and enter a positive dB value and then press the appropriate submenu key (dB External Gain or dB External Loss). The new RL Offset value will be displayed on the instrument and reference level is adjusted.

Set the Span

1. Press the Span main menu key or the Freq main menu key followed by the Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

| Note | To quickly move the span value up or down, press the Span Up 1-2-5 or Span Down 1-2-5 submenu keys. These keys facilitate a zoom-in, zoom-out feature in a 1-2-5 sequence. |

Single Limit Line

Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

5. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.
Create a Limit Envelope

1. Press **Shift**, then **Limit** (6) to display the Limit menu.
2. Select Limit Envelope.
3. Press the Create Envelope key.

---

**Figure 3-2.** Limit Envelope
Setting Up Markers

Press the **Marker** main menu key to display the Marker menu.

**Selecting, Activating, and Placing a Marker**

1. Press the **Marker 1 2 3 4 5 6** submenu key and then select the desired marker using the touch screen marker buttons. The selected marker is underlined on the **Marker** submenu key.
2. Press the **On Off** submenu key so that **On** is underlined. The selected marker is displayed in red and ready to be moved.
3. Use the rotary knob to place the marker on the desired frequency.
4. Repeat steps 1 through 3 to activate and move additional markers.

**Selecting, Activating, and Placing a Delta Marker**

1. Press the **Marker 1 2 3 4 5 6** submenu key and select the desired delta marker. The selected marker is underlined.
2. Press the **Delta On Off** submenu key so that **On** is underlined. The selected marker is displayed in red and ready to be moved.
3. Use the rotary knob to place the delta marker on the desired frequency.
4. Repeat steps 1 through 3 to activate and move additional markers.

**Viewing Marker Data in a Table Format**

1. Press the **More** submenu key.
2. Press the **Marker Table** submenu key so that **On** is underlined. All marker and delta marker data are displayed in a table under the measurement graph.

---

**Figure 3-3. Marker Table**

```
<table>
<thead>
<tr>
<th>Ref Lvl</th>
<th>-83.6 dBm</th>
<th>959.630 MHz</th>
<th>363 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Att</td>
<td>0.0 dB</td>
<td>170 dB</td>
<td></td>
</tr>
<tr>
<td>Detection Peak</td>
<td>1 MHz</td>
<td>1 MHz</td>
<td></td>
</tr>
<tr>
<td>RBW</td>
<td>1 MHz</td>
<td>1 MHz</td>
<td></td>
</tr>
<tr>
<td>Sweep Time</td>
<td>750 ms</td>
<td>750 ms</td>
<td></td>
</tr>
<tr>
<td>Traces</td>
<td>A, Normal</td>
<td>A, Normal</td>
<td>A, Normal</td>
</tr>
<tr>
<td>Sweep (Set) Connected</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freq Ref</td>
<td>8.1 MHz</td>
<td>8.1 MHz</td>
<td></td>
</tr>
<tr>
<td>Freq Ref</td>
<td>8.1 MHz</td>
<td>8.1 MHz</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Marker</th>
<th>1 2 3 4 5 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>OFF</td>
</tr>
<tr>
<td>Delta</td>
<td>On</td>
</tr>
<tr>
<td>Peak Search</td>
<td></td>
</tr>
<tr>
<td>Marker Freq to Center</td>
<td></td>
</tr>
<tr>
<td>Marker to Ref Lvl</td>
<td></td>
</tr>
<tr>
<td>More</td>
<td>Peak Options</td>
</tr>
<tr>
<td>More</td>
<td></td>
</tr>
</tbody>
</table>
```

F: 59.969 MHz

A: 859.636 MHz

B: 1059.636 MHz

C: 1259.636 MHz

D: 1459.636 MHz

E: 1659.636 MHz

F: 1859.636 MHz

G: 2059.636 MHz

H: 2259.636 MHz

I: 2459.636 MHz

J: 2659.636 MHz

K: 2859.636 MHz

L: 3059.636 MHz

M: 3259.636 MHz

N: 3459.636 MHz

O: 3659.636 MHz

P: 3859.636 MHz

Q: 4059.636 MHz

R: 4259.636 MHz

S: 4459.636 MHz

T: 4659.636 MHz

U: 4859.636 MHz

V: 5059.636 MHz

W: 5259.636 MHz

X: 5459.636 MHz

Y: 5659.636 MHz

Z: 5859.636 MHz

---
Select a Measurement Type

In Spectrum Analyzer mode, press **Shift**, then **Measure** (4) and select a measurement using the submenu keys.

---

**Figure 3-4.** Spectrum Analyzer Measure Menu
External Power On

The *When DC Applied* setting in the Power-On menu allows the instrument to restart automatically when external DC power is applied to the connector shown in Figure 2-14 on page 2-15. Refer to “External Power” on page 2-16 and the “Power-On Menu” on page 5-6.

When this feature is enabled, the instrument in the off state will turn on when external DC power is applied. The instrument turns off when external power is removed, even if a battery is installed. This is useful for high-reliability remote operation, where the instrument may need to be rebooted using a remotely-controlled power switch.

If the instrument is turned on with the power switch, then external power is removed, the instrument will continue to run until the battery is depleted. It will come on and the battery will begin recharging when external power is applied. This state is useful when the instrument is in a location where the power source may be interrupted.
Chapter 4 — File Management

4-1 Introduction

This chapter describes the file management features of the Spectrum Master and the related touch screen menus. The File menu and its submenus allow you to save, recall, copy, and delete files in internal memory or an external USB flash drive.

4-2 Managing Files

Press the **Shift** key, then the **File (7)** key on the numeric keypad to display the File menu.

---

**Note**

When navigating through the File menu, press the **Esc** key to return to the previous menu or submenu. Any changes not yet applied (by pressing Enter) are canceled.

---

**File Types**

Under the Save, Recall, Copy, and Delete menus, press the **Change Type** or the **File Type** submenu key to open the Select File Type list box, where you can select the desired file type.

Available file types depend on the current instrument mode. The Select File Type list box may contain the following entries:

- **ALL** (displays all file types)
- **Setup**, *.stp
  (Setup files contain basic instrument information, measurement mode setup details, measurement marker data, and limit data.)
  (Measurement files contain all of the information in the setup files and the measurement data. File extensions are determined by the current measurement mode and selected file type.)
- **JPEG**, *.jpg
  (Image file is a screen capture of the current measurement display.)
- **Limit Lines**, *.lim
  (The Limit Line file contains limit line data details.)
- **Spurious Emission Mask**, *.spe
  (The Spurious Emission Mask file contains the frequency, amplitude, and other information related to segments in an out-of-band spurious emission mask.)
- **KML 2D**, *.kml
- **KML 3D**, *.kml
- **Mapping Tab Delimited**, *.mtd

You can also use the touch screen to open the drop down list for the Filetype entry box, as shown in Figure 4-1 on page 4-2.
Save Files
The submenu keys that are available for file management may vary with instrument options and measurement modes. Refer to “File Menu” on page 4-9.

Save Measurement As
The Save Measurement As submenu key provides a one-touch method of saving the current measurement data. The name of the file that will be saved is displayed on the submenu key. The numerical suffix increments by 1 following the Save. For example, if the last measurement was saved with the file name ACPR, the Save Measurement As shows the default file name for the next measurement to be saved as ACPR_1, then ACPR_2, and so on. To save using a different file name than the default, press the Save Measurement key or the Save key instead of Save Measurement As.

Save Measurement
To save the current measurement data, use the Save Measurement As submenu key described above or, to apply a different file name or save location than the default, press the Save Measurement submenu key or the Save key. In the Save dialog, you can enter the file name and select the type of data to save. See Figure 4-1 and refer to “Save Dialog Box” on page 4-3.

Save
The Save submenu key has the same function as Save Measurement. It opens the Save dialog box and menu illustrated in Figure 4-1.

![Figure 4-1. Save Dialog Box](image-url)
Save Dialog Box

In the Save dialog, use the touch screen keyboard to enter the name of the file to save. See Figure 4-1 on page 4-2. Optionally, you can use the Quick Name keys to insert preset text strings into the file name. Refer to “Quick Name Keys”.

To select the type of data to save, either press the Filetype selection box to display the drop down list of available file types, or press the Change Type submenu key. Selectable file types vary with the measurement mode. Use the Up/Down arrow keys to highlight the desired file type, then press Enter to select.

Press Enter again to save the file. File name extensions are automatically assigned based on the file type and measurement mode. Refer to “File Types” on page 4-1.

Quick Name Keys

Quick Name keys in the Save dialog provide optional building blocks for entering file names. They function as keyboard shortcuts, allowing you to enter predefined, frequently used file names or parts of file names. To enter or change a Quick Name, press the Change Quick Name submenu key in the Save menu, then select the item to edit (see Figure 4-2) and press Enter on the numeric keypad. In the Edit Quick Name dialog, use the touch screen keyboard to enter a new Quick Name. See Figure 4-3. Press Enter again and the new name will be displayed on the key, in the Save dialog.

![Select Quick Name to edit](image)

**Figure 4-2. Select Quick Name List Box**

![Edit Quick Name Dialog Box](image)

**Figure 4-3. Edit Quick Name Dialog Box**
Change Save Location

You can save files to internal memory or to an external USB flash drive. To change the destination location of the saved file, press the Change Save Location submenu key under the Save menu. Figure 4-4 illustrates the directory structure of the instrument’s internal memory and external USB drive or drives, if connected. Only folders are listed, not files.

Figure 4-4. Save Location Screen

Use the touch screen, the Up/Down arrow keys, or the rotary knob to select a folder from the list. To expand a folder and view its subfolders, press Enter or the Right arrow key. Press Enter again or the Left arrow key to collapse the folder. To create a new folder, press the Create Folder submenu key.

After selecting the folder, press the Set Location key to store the save location. Refer to “Save Location Menu” on page 4-11 for a description of the submenu keys.

Save On Event

This menu is not available in all modes of operation. The menu is used to automatically save measurement data to the current save location after a selected event type. Refer to “Save On... Menu” on page 4-12.
Recall Files

Press the Recall Measurement key or the Recall key under the File menu to recall a previously saved file from internal memory or an external USB drive, if connected. The files listed in the Recall dialog box depend on the file type selected. See Figure 4-5. JPEG image files cannot be recalled.

![Recall Dialog Box](image)

**Figure 4-5.** Recall Dialog Box

The submenu keys let you change the file types and sort order of the displayed file list. Refer to “Recall Menu” on page 4-13.

The Filetype drop down list has the same function as the File Type submenu key. Selectable file types vary with the measurement mode. Use the touch screen, rotary knob, or the Up/Down arrow keys to select the file you wish to recall, then press Enter.

From the Recall dialog box, you can create a shortcut to a setup file and place the shortcut icon on the instrument’s Menu screen. Refer to “User-Created Shortcuts” on page 2-5.
Copy Files

Press the Copy key under the File menu to open the Copy dialog box and menu, where you can copy a single or multiple files or folders. The source and destination locations may be the instrument’s internal memory or an external USB drive, if connected. The source files listed in the Copy dialog box depend on the chosen file type, which is selected using either the Filetype drop down list or the File Type submenu key. You can also change the way folders and files are sorted in the displayed list. Refer to “Copy Menu” on page 4-14.

The Filetype drop down list has the same function as the File Type submenu key. Selectable file types vary with the measurement mode. Files and folders to copy are listed in the top pane of the Copy dialog box. Select the destination in the bottom pane. See Figure 4-6.

1. To copy to or from an external USB drive, insert the flash drive into a USB port on the instrument. Otherwise, skip to the next step.
2. Press the Shift key, followed by File (7), then press the Copy submenu key.
3. Use the submenu keys to select the type of file to copy and the display order of folders and files, as appropriate.
4. Make sure the Scroll submenu key is toggled to Src (source).
5. Use the touch screen, rotary knob, or the Up/Down arrow keys to locate and highlight (that is, frame) the file or folder you wish to copy. To open a highlighted folder, press Enter. Press Enter again or press the Left arrow key to close it.
6. To select a highlighted file or folder for copying, press the Select or De-Select submenu key. The selected item is highlighted in blue.
7. If needed, repeat Step 5 and Step 6 to select more files or folders to copy.

Figure 4-6. Copy Dialog Box
8. Press the Scroll key to switch navigation control to the Dst (destination) pane. Alternatively, you can directly press a folder in the bottom pane to select it.

9. If the destination folder is off the screen, use the rotary knob or the Up/Down arrow keys to locate and select it.

10. Press the Copy key to copy the selected files or folders.

If a file by the same name already exists in the destination location, an error message is displayed, prompting you to press Enter to overwrite, or Esc to skip the conflicting file.

### Delete Files

Press the Delete key under the File menu to open the Delete dialog box and menu, where you can delete a single or multiple files or folders. Items to be deleted may be in the instrument’s internal memory or an external USB drive, if connected. However, you cannot select files and folders located in different drives simultaneously.

The files listed in the Delete dialog box depend on the chosen file type, which is selected using either the Filetype drop down list or the File Type submenu key. You can also change the way folders and files are sorted in the displayed list. Refer to “Delete Menu” on page 4-15.

![Delete Dialog Box](image)

**Figure 4-7. Delete Dialog Box**

Use the touch screen, rotary knob, or the Up/Down arrow keys to highlight the file or folder you wish to delete. Then, press the Select or De-Select submenu key. The selected item is highlighted in blue. Pressing the key again deselects the current item.

To delete multiple files or folders, scroll to the next item and press the Select or De-Select key. Press the Delete key, then confirm or cancel the deletion in the confirmation box.
4-3 File Menu Overview

Open this menu by pressing the **Shift** key, then the **File** (7) key.

Figure 4-8. File Menu
4-4 File Menu

Key Sequence: **Shift > File (7)**

**Save Measurement As:** Pressing this key will save instrument setup parameters, trace data, and any measurement results to the file that is named on the submenu key. Upon Save completion, the file name numerical suffix increments by 1 and will be applied to the next Save. The file extension is determined by the current measurement mode, such as .spa for Spectrum Analyzer mode.

To save to a different file name than the default shown, or to change the save location, use the Save Measurement or the Save submenu key.

**Save Measurement:** Press this submenu key to display the “Save Menu” and Save dialog box. You can optionally enter a different file name using the keyboard in the Save dialog. You may also select the file type from the drop down list, as illustrated in Figure 4-11 on page 4-10. The list of available file types varies with the measurement mode.

Press **Enter** to save to the named file and return to the File menu. Pressing **Esc** exits the Save menu and dialog without saving.

The destination file for the saved data may be in the instrument’s internal memory or an external drive, typically a USB drive. To change the save location, refer to the “Save Location Menu” on page 4-11.

**Save:** Press this submenu key to display the “Save Menu” and Save dialog box. The available settings are the same as those of the Save Measurement key.

**Save on Event** (Not available in all measurement modes): Press this submenu key to display the “Save On... Menu” on page 4-12.

**Recall Measurement:** Press this submenu key to display the “Recall Menu” on page 4-13. Use this menu to recall measurement files from internal memory or an external drive, such as a USB memory stick.

**Recall:** Press this submenu key to display the “Recall Menu” on page 4-13. The available settings are the same as those of the Recall Measurement key. Use this menu to recall files (such as measurements, setups, limit lines, maps) from internal memory or an external drive.

**Copy:** Press this submenu key to display the “Copy Menu” on page 4-14. Use this menu to copy files and folders. The source and destination locations may be the instrument's internal memory or an external USB drive.

**Delete:** Press this submenu key to display the “Delete Menu” on page 4-15 and a selection box that lists the contents of internal memory and an external drive if connected. Use the rotary knob or the **Up/Down** arrow keys to scroll to the file that is to be deleted and press the Select or De-Select submenu key, then Delete. Press the **Esc** key to cancel the operation. Note that deleted files cannot be recovered.

**Figure 4-9.** File Menu
Save Menu

Key Sequence: Shift > File (7) > Save Measurement
Key Sequence: Shift > File (7) > Save

**Restore Default Quick Name Buttons:** Press this submenu key to undo any Quick Names previously entered and return all Quick Name buttons to factory defaults.

**Change Quick Name:** Press this key to change the Quick Names at the bottom of the touch screen keyboard (see Figure 4-11). Select the Quick Name to edit, then press Enter. Type the new Quick Name and press Enter again. The new Quick Name is displayed on the button below the keyboard.

**Change Save Location:** Press this submenu key to open the “Save Location Menu”, where you can set the location of the destination file for saved data.

**Change Type**
**Setup/JPEG/...:** Press this submenu key to open the Select File Type list box and the “File Type Menu”.

Figure 4-10. Save Menu

Figure 4-11. Save Dialog Box
File Type Menu

Key Sequence: Shift > File (7) > Save Measurement > Change Type
Key Sequence: Shift > File (7) > Save > Change Type

JPEG Capture

**Full**         **Graph Only**: Press this submenu key to toggle between file types, Full and Graph Only. Choose Full to include all of the additional data on the measurement screen. Choose Graph Only to capture just the measurement trace in the sweep window.

**Figure 4-12.** File Type Menu

Save Location Menu

Key Sequence: Shift > File (7) > Save > Change Save Location

**Sort By**

**Name**    **Type**    **Date**: Press this submenu key to choose the item by which folders are sorted in the Select Save Location list. See Figure 4-4 on page 4-4.

**Sort Order**

**Ascend**   **Descend**: Press this key to toggle the sort order of the folder list between Ascending and Descending.

**Create Folder**: Press this submenu key to create a new folder inside the selected directory. Enter the new folder name in the Create Directory dialog and press **Enter**. To return to the Select Save Location dialog without creating a new folder, press **Esc**.

**Set Location**: Press this submenu key to set the currently selected folder as the destination where saved files will be stored, and to return to the “Save Menu” on page 4-10. Press **Esc** to exit without saving.

**Refresh Directories**: Press this key to update the folder list after connecting or disconnecting an external USB drive.

**Figure 4-13.** Save Location Menu
Save On... Menu

Key Sequence: Shift > File (7) > Save On Event

In Spectrum Analyzer mode, this menu is used to automatically save measurements to the current save location after any of the following events:

**...Crossing Limit**

On  Off:
When this submenu key is set to On, measurement data is automatically saved when the trace crosses a limit line that has been specified with the Limit menu.

**...Sweep Complete**

On  Off: When this key is set to On, measurement data is automatically saved after the current sweep is completed.

**Save Then Stop**

On  Off: Set this key to On to stop the sweep after a measurement is saved. If this setting is Off and Sweep Complete is On, a measurement is saved after every sweep.

**Clear All**: Press this key to turn Off all three Save On Event keys:
- Crossing Limit
- Sweep Complete
- Save Then Stop

**Back**: Press this key to return to the “File Menu” on page 4-9.

Figure 4-14. Save On Menu
Recall Menu

Key Sequence:  **Shift > File (7) > Recall**

Use these menu keys to change the way files are listed in the Recall dialog box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced by the stored setup information. When recalling a saved measurement and multiple traces are displayed, parameter settings shown on the instrument screen may reflect those of the recalled trace or the active trace, depending on the measurement mode or other factors.

**Sort By**

Name  Type  Date: Press this submenu key to choose the item by which folders and files are sorted in the Recall dialog box. See Figure 4-5 on page 4-5.

**Sort Order**

Ascend  Descend: Press this key to toggle the sort order of the file list between Ascending and Descending.

**File Type:** Press this submenu key to open the Select File Type list box. Press the desired file type on the list, then press Enter to apply the selection. JPEG image files cannot be recalled and are not listed.

Alternatively, you can select directly from the Filetype drop down list in the Recall dialog box.

**Refresh Directories:** Press this key to update the file list after connecting or disconnecting an external USB drive.

---

**Figure 4-15.** Recall Menu
Copy Menu

Key Sequence: **Shift > File (7) > Copy**

### Sort By
- **Name**: Press this submenu key to choose the item by which folders and files are sorted in the Copy dialog box. See Figure 4-6 on page 4-6.
- **Type**: Press this key to toggle the sort order of the file list between Ascending and Descending.
- **Date**: Press this key to open the Select File Type list box. Press the desired file type on the list, then press **Enter** to apply the selection. Alternatively, you can select directly from the Filetype drop down list in the Copy dialog box.

### Sort Order
- **Ascend**
- **Descend**

### Scroll
- **Src Dst**: Press this submenu key to shift navigation control between the source and destination panes in the Copy dialog box.

### Select or De-Select

### Copy

**Copy**:Copies the selected files and folders, highlighted in blue in the top pane of the Copy dialog box, to the selected location in the bottom pane. If a file by the same name already exists in the destination location, an Error message is displayed, prompting you to press **Enter** to overwrite, or **Esc** to skip the conflicting file.

---

**Figure 4-16.** Copy Menu
Delete Menu

Key Sequence: **Shift > File (7) > Delete**

Sort By
**Name  Type  Date:** Press this submenu key to choose the item by which folders and files are sorted in the Delete dialog box. See Figure 4-7 on page 4-7.

Sort Order
**Ascend  Descend:** Press this key to toggle the sort order of the file list between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box. Press the desired file type on the list, then press **Enter** to apply the selection. Alternatively, you can select directly from the Filetype drop down list in the Delete dialog box.

Select or De-Select: Press this key to select or deselect the current file or folder. Selected items are highlighted in blue.

Delete: Deletes the selected files or folders, which are highlighted in blue. In the confirmation box, press Yes to delete, No to cancel. You can also press **Esc** to cancel the deletion.

Refresh Directories: Press this key to update the file list after connecting or disconnecting an external USB drive.

*Figure 4-17.* Delete Menu
Chapter 5 — System Operations

5-1 Introduction

This chapter reviews the Spectrum Master system operations and related menus. The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement Guides listed in Appendix A.
5-2 System Menu Overview

To access the System menu functions, press the **Shift** key, then the **System** (8) key.

---

**Figure 5-1. System Menu**

1. Ethernet functionality is standard on Revision 3 instruments. Earlier Revision instruments must be equipped with Option 413.

---

1. Ethernet functionality is standard on Revision 3 instruments. Earlier Revision instruments must be equipped with Option 413.
## 5-3 System Menu

### Key Sequence: Shift, System (8)

<table>
<thead>
<tr>
<th>System Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status: Pressing this submenu key displays the current system status, including the operating system and firmware versions, temperatures and other details such as current battery information. Press Esc or Enter to return to normal operation.</td>
<td></td>
</tr>
<tr>
<td>Self Test: This key initiates a series of diagnostic tests related to the performance of the motherboard hardware. A display will list the individual tests with a pass or fail indication. Press Esc or Enter to return to normal operation.</td>
<td></td>
</tr>
<tr>
<td>Application Self Test: This key initiates a series of diagnostic tests related to the performance of the instrument for specific applications. A display will list the individual tests with a pass or fail indication. Press Esc or Enter to return to normal operation.</td>
<td></td>
</tr>
<tr>
<td>GPS:Opens the “GPS Menu” on page 6-4.</td>
<td></td>
</tr>
<tr>
<td>Calibrate Touch Screen: If the instrument does not respond as expected when you press the touch screen, press this key to display the touch screen calibration message box. Refer to “Touch Screen Calibration” on page 2-10.</td>
<td></td>
</tr>
<tr>
<td>Application Options: This submenu changes with the measurement mode. Refer to the appropriate Measurement Guide, as listed in Appendix A.</td>
<td></td>
</tr>
<tr>
<td>System Options: This key opens the “System Options Menu” on page 5-4.</td>
<td></td>
</tr>
</tbody>
</table>

### Figure 5-2. System Menu
System Options Menu

Key Sequence: **Shift, System (8) > System Options**

- **Date and Time:** Press this submenu key to display a dialog box for setting the current date and time. Use the submenu keys or the **Left/Right** arrow keys to select the field to be modified. Use the keypad, the **Up/Down** arrow keys, or the rotary knob to select the date and time. Press **Enter** to accept the changes, or press the **Esc** key to return to normal operation without making changes.

- **Ethernet Config:** This submenu key is present only when Ethernet is installed. Press the key to display the Ethernet submenu and to open the Ethernet Editor dialog box, where you can set the instrument IP address. For details, refer to “Ethernet Menu” on page B-2.

- **Language:** Press this submenu key to open a list box and select a built-in language for the instrument display. Press **Enter** to apply the change, or press **Esc** to cancel.

  The languages that are currently available are: English, French, German, Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You can edit non-English language captions using Master Software Tools (MST). If a mode does not have language translations available, then English is the default language.

  **Caution:** A firmware update or any instrument reset will overwrite modifications you may have made in any of the language files.

- **Display:** The Display submenu key opens the “Display Settings Menu” on page 5-7, allowing brightness control and the selection of different display attributes.

- **Name:** Press this submenu key to open the Unit Name dialog, where you can enter a name for the instrument, using the touch screen keyboard. Press **Enter** to save the name.

  The assigned instrument name appears in measurement files, setup files, limit line files, and MST reports. It is displayed on the browser page banner when the instrument is connected to a remote PC or mobile device.

- **Volume:** Press this submenu key to view or adjust the speaker volume. The current volume setting is displayed in the Volume input box. Use the numeric keypad, the **Up/Down** arrow keys, or the rotary knob to change the value, and press **Enter** to apply the change.

- **Reset:** Press this submenu key to open the “Reset Menu” on page 5-9.

- **More:** Press this submenu key to open the “System Options 2/2 Menu” on page 5-5.

---

Figure 5-3. System Options Menu
System Options 2/2 Menu

Key Sequence: Shift, System (8) > System Options > More

<table>
<thead>
<tr>
<th>System Options 2/2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share CF &amp; Pwr Offset</td>
</tr>
<tr>
<td>All Modes  Not Shared:</td>
</tr>
<tr>
<td>Set Remote Access Password</td>
</tr>
<tr>
<td>Power–On</td>
</tr>
<tr>
<td>Back</td>
</tr>
</tbody>
</table>

Set Remote Access Password: Press this submenu key to open the Password entry dialog (see Figure 5-5 on page 5-6). Use the touch screen keyboard to enter the new password. Passwords may contain digits, uppercase and lowercase letters, and the symbols - _ + . (hyphen, underscore, plus, period). Press Enter to save or Esc to cancel.

Setting the remote password and rebooting the instrument will lock it from Telnet and FTP connections. This means that connecting to the instrument via Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT), or the Web Remote Control browser interface will require the set password. To unlock the instrument, remove the password by setting it to blank. The password is also removed following a Master Reset, Factory Defaults reset, or a firmware update.

Power–On: Press this submenu key to open the “Power-On Menu” on page 5-6.

Back: Press this submenu key to return to the “System Options Menu” on page 5-4.

![Figure 5-4. System Options 2/2 Menu](image)

Warning

Do not set a remote access password when using SCPI commands to communicate with the instrument.
Power-On Menu

Key Sequence: **Shift, System** (8) > System Options > More > Power–On

**Power Switch:** Press this submenu key to set the instrument for normal use of the On/Off button on the instrument front panel.

**When DC Applied:** Press this submenu key to set the instrument to automatically restart when DC power is applied to the External Power connector (see Figure 2-14 on page 2-15). Refer to “External Power On” on page 3-8.

**Back:** Press this submenu key to return to the “System Options 2/2 Menu” on page 5-5.
Display Settings Menu

Key Sequence: Shift, System (8) > System Options > Display

**Brightness:** Opens the “Brightness Settings Menu” on page 5-8.

**Display Blank:** Opens the message box illustrated in Figure 5-8. Press Enter to turn off the display, or press Esc to abort. To turn the display back on, press any key (except the Power button) three times in rapid succession. A power cycle also turns the display back on.

**Default Colors:** Sets the display colors to the factory defaults. Used for normal viewing.

**Black on White:** Sets the display colors to black on a white background. Used for printing and viewing in broad daylight conditions. See Figure 2-8 on page 2-9 for illustrations of the display color schemes selectable in this submenu.

**Night Vision:** Sets the display to a red-tinted color on a black background. The front panel keypad is backlit in red. This setting is optimized for nighttime viewing.

**High Contrast:** Increases the black and white contrast of the default display. This setting is used in challenging viewing conditions.

**Color on White:** Sets the display background to white, the grid to gray, and leaves sweep data in color. This setting is used for printing and viewing in broad daylight conditions.

**Back:** Press this submenu key to return to the “System Options Menu” on page 5-4.

---

![Display Settings Menu Diagram](image)

**Figure 5-7.** Display Settings Menu

---

![Display Blank Message Box](image)

**Figure 5-8.** Display Blank Message Box
Brightness Settings Menu
Key Sequence: Shift, System (8) > System Options > Display > Brightness

The brightness of the display can be adjusted to optimize viewing under a wide variety of lighting conditions.

**Brightness:** Press this submenu key to open the Brightness Editor window, where you can adjust the display brightness level from 0 to 100, with 100 being the brightest. See Figure 5-10. Use the rotary knob to adjust the value in increments of 5, or press the Up/Down arrow keys to change the value in increments of 25. Press the Left or the Right arrow key to jump to 0 or 100, respectively. Press Enter to accept the change. All display elements on the instrument screen are affected by the Brightness setting.

**Auto Dim On/Off:** Press this submenu key to toggle the display auto-dimming feature on and off. Enabling auto-dim can extend battery life.

**Auto Dim Delay:** Press this key to adjust the amount of idle time, from 1 to 15 minutes, before the instrument display goes dim. Use the arrow keys or the rotary knob to adjust the value in increments of 1. You can also use the numeric keypad, then press Enter. Out-of-range values are ignored.

**Auto Dim Brightness:** Press this submenu key to select the brightness percentage level of the display when it is dimmed. Use the arrow keys or the rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can also use the numeric keypad, then press % or the Enter key. Out-of-range values are ignored.

**Back:** Press this submenu key to return to the “Display Settings Menu” on page 5-7.

---

**Figure 5-9.** Brightness Settings Menu

**Figure 5-10.** Brightness Editor Input Box
Reset Menu

Key Sequence: Shift, System (8) > System Options > Reset

**Factory Defaults:** Press this key to restore the instrument to the default settings for all measurement modes and system settings, including connectivity, language, and the display and audio settings. The instrument will power cycle when the operation is complete. Press the Enter key to initiate the reset, or press Esc to abort.

**Note:** This same reset sequence can be initiated when turning on the instrument by pressing Power while holding down the Esc key until the Anritsu splash screen is displayed.

**Master Reset:** Press this submenu key to restore the instrument to factory defaults as described above and to delete all user files from the instrument internal memory. The instrument will power cycle when the operation is complete. Press Enter to initiate the reset, or press Esc to abort.

**Note:** This same reset sequence can be initiated when turning on the instrument by pressing Power while holding down the System (8) key until the Anritsu splash screen is displayed.

**Update Firmware:** Press this submenu key to update the instrument operating system using an external USB drive. Press Load Firmware to start the update procedure, or press the Menu key to cancel and display the Menu key screen of application icons. Refer to “Firmware Update” on page 5-11 for additional information on firmware update options.

**Back:** Press this submenu key to return to the “System Options Menu” on page 5-4.

Figure 5-11. Reset Menu
5-4 Preset Menu

Key Sequence: Shift, Preset (1)

| Preset | Preset | Save | Setup | Recall | Setup |

**Preset:** This key resets all parameter settings for the current measurement mode to their factory default values, and switches the display to the default view for that mode. Measurement settings specific to other modes, or applications, are not affected.

**Save Setup:** Opens the Save dialog box (see Figure 4-1 on page 4-2) to name and save the current operating settings, allowing them to be recalled later to return the instrument to the state it was in at the time the setup was saved.

The saved setup can be named using the touch screen keyboard. Use the Caps key to select an uppercase letter. Use the Left/Right directional arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-10 for details.

**Recall Setup:** This key allows the selection and recall of a previously stored instrument setup using the “Recall Menu” on page 4-13. Use the rotary knob, the Up/Down arrow keys, or the touch screen to highlight the saved setup, and press Enter. All current instrument settings are replaced by the stored setup information.

**Figure 5-12.** Preset Menu

5-5 Self Test

At power on, the Spectrum Master runs through a series of quick checks to ensure that the system is functioning properly. The System self test runs a series of tests that are related to the instrument hardware. The Application self test runs a series of tests related to the instrument hardware that is used in the current operating mode.

If the Spectrum Master is within the specified operating range with a charged battery and the self test fails, contact your Anritsu Service Center at anritsu.com/contact-us.

To initiate a self test when the system is already powered up:

1. Press the Shift key, followed by the System (8) key.
2. Press the Self Test submenu key. The Self Test results are displayed.
3. Press Esc to close the Self Test results dialog.
5-6 Firmware Update

To update your Anritsu instrument firmware, use a high quality USB memory device with at least 250 MB of free space and FAT32 file system format.

1. Insert the memory device into your PC or laptop.
2. From a browser, go to the following Anritsu Products page:
3. If the Web page lists more than one product, find your instrument model number and click the link.
4. On the product page, press the Downloads button.
5. Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware Revision/Release History link to download a document detailing current and past firmware changes.
6. Click on the link Firmware Update for the Spectrum Master MS271xE.
7. Click the Download button, then choose Save or Save As. Do not run the executable file directly from the Web page.
8. Go to the Save location designated in Step 7 and double-click the installer file, Model_Ver_USBLoader.exe.
9. In the Firmware Update dialog, click to view, then accept the software license agreement.
10. Click Browse and select the Removable Disk drive where the USB device is inserted.
11. Click Prepare USB Memory Stick to create the firmware update USB device.
12. After the firmware update tool has finished, click through the final steps in the Firmware Update dialog to close the installer program.
13. Eject the memory device from the computer.

**Note**  The file structure created on the USB memory device by the installer program is necessary for a successful firmware update and must not be altered in any way.

14. Turn off the Spectrum Master and insert the USB memory device into the instrument.
15. Make sure the Spectrum Master is plugged into an AC power source and not running on battery alone, then turn on the instrument.
16. At bootup, the instrument should detect new firmware on the USB device and ask if you wish to upgrade. Press Yes.
17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19.

**Note**  If the same firmware code as contained on the USB device is already loaded on the instrument, a message indicating that firmware update is skipped will display briefly on the instrument screen.

If the firmware update on the memory device does not match your instrument model, an error message will display briefly, indicating that it is not compatible.
18. If there is no error but the instrument does not enter upgrade mode automatically:
   a. Press Shift > System (8) > System Options > Reset > Update Firmware.
   b. Press Load Firmware at the bottom left of the instrument screen.
   c. Press Update Application Firmware.
   d. The Firmware Update dialog opens.

19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.
   - Save none: No attempt is made to save any user data.
   - Save user data: User data is saved to the selected external media device.
   - Save & restore user data: User data is saved to the selected external media device. The instrument also attempts to restore the files to the instrument after the update.

   **Warning** Some user data may be lost if not enough memory space is available on the selected device.

20. Press Enter.

21. Press Enter again to confirm your intention to proceed with the firmware upgrade.

   To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and select an application from the Mode Selector list in order to exit upgrade mode and resume normal instrument operation.

   **Warning** You cannot stop the upgrade once it has started. To avoid potential permanent damage, do not turn off the instrument or remove the USB memory device during the firmware update.

22. After the update is complete, the instrument should reboot automatically.

   **Note** If the instrument turns off and does not restart on its own, remove the USB memory device and turn on the instrument by holding down the System (8) key, then pressing the Power button. Keep pressing System (8) until the Anritsu splash screen is displayed.

   Be sure to use this key combination in order to perform a Master Reset while turning on the instrument. Pressing the Power button alone may put the instrument in an unrecoverable error state.
Chapter 6 — GPS (Option 31)

6-1 Introduction

The Spectrum Master is available with a built-in GPS receiver feature (Option 31) that can provide latitude, longitude, altitude, and UTC timing information. This option also enhances frequency reference oscillator accuracy in the spectrum analyzer mode. When GPS is actively locked to satellites, this information is saved with all saved measurements and can be displayed with Master Software Tools. No accuracy specifications apply if no GPS satellites are acquired.

| Note | The Spectrum Master Technical Data Sheet provides a list of the options and measurements that require GPS (Option 31). In addition to having Option 31 installed, a GPS antenna is required. Refer to the instrument Technical Data Sheet for compatible GPS antennas. |

6-2 Activating the GPS Feature

Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

1. Press the Shift key, then the System (8) key on the numeric keypad to display the System menu.
2. Press the GPS submenu key.
3. Activate GPS by pressing the GPS On/Off submenu key so that On is underlined. When GPS is first turned On, the GPS icon is displayed in red to indicate that fewer than four satellites are currently being tracked.

Figure 6-1. GPS Icon, Red
4. When the GPS receiver is tracking at least four satellites, the GPS icon changes to green. Latitude and longitude information is displayed in the title bar at the top of the display. Acquiring satellites may take as long as three minutes.

![GPS Icon, Green](image)

**Figure 6-2.** GPS Icon, Green

5. Press the **GPS Info** submenu key to display the following information:
   - Tracked satellites
   - Latitude and longitude
   - Altitude
   - UTC timing information
   - Fix available
   - Almanac complete
   - Antenna and receiver status
   - GPS antenna voltage and current

   Refer to “GPS Menu” on page 6-4 for details on the above GPS Info items.

After GPS location fix is attained, the internal reference oscillator begins to correct its frequency to match the GPS standard. After the internal frequency is adjusted to match the GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu, which is displayed on the left side of the measurement display. When the GPS feature is not enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of better than 50 ppb (parts per billion).

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, or the antenna must be placed outside with no obstructions.

If no GPS is connected, the Frequency Reference annotation reads **Int Std Accy**. When GPS is connected, with a fix, and the tuning process has completed (which may take a few minutes), the Frequency Reference annotation shows **GPS Hi Accy**. If GPS is subsequently lost (for example, GPS is turned off, disconnected, or there is no signal due to physical obstruction), the instrument goes back to **Int Std Accy** after a few moments.
6-3 Resetting GPS

To reset the GPS, press the Reset submenu key. The green GPS icon shows a red cross mark when satellite tracking is lost after tracking four or more satellites. The GPS latitude and longitude are saved in the instrument memory until the Spectrum Master is turned off or until GPS is turned off by using the GPS On/Off key.

![GPS Icon, Tracking Lost](image_url)

6-4 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information
The GPS coordinates of a location can be saved along with a measurement trace. Refer to “Save Menu” on page 4-10 for more information. The current GPS coordinates will be saved with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information
If the GPS coordinates were saved with a measurement, the coordinates will be recalled when the measurement is recalled. Refer to “Recall Menu” on page 4-13 for more information on recalling a saved trace.
6-5 GPS Menu

Key Sequence: Shift, System (8) > GPS

**GPS:** Press this submenu key to turn GPS on or off.

**GPS Info:** Press this submenu key to display the current GPS information.

- **Tracked Satellites:** Shows the number of tracked satellites (three are required to retrieve latitude and longitude, four are required to resolve altitude). Generally, the larger the number of satellites tracked, the more accurate the GPS information.

- **Latitude and Longitude:** Shows location in degrees, minutes, and seconds.

- **Altitude:** Shows altitude information in meters.

- **UTC:** Universal Coordinated Time.

- **Fix Available:** The cold start search sets are established to ensure that at least three satellites are acquired within the first couple of minutes. When three satellites are found, the receiver will compute an initial fix (typically in less than two minutes). **Fix Available: No** means that the initial position has not been established.

- **Almanac Complete:** The system almanac contains information about the satellites in the constellation, ionospheric data, and special system messages. In a cold start, the GPS receiver has no navigation data, so the receiver does not have a current almanac. A complete system almanac is not required to achieve a first position fix. However, UTC time is not correct until the almanac is complete, and the availability of the almanac can significantly reduce the time to first fix.

- **Antenna Status:**
  - OK: Active antenna is connected and is working properly.
  - Short/Open: If an active antenna is in use, a short or open exists between the antenna and the connection. If this message is displayed, replace the antenna. If the message persists, try another Anritsu GPS antenna. If needed, contact your nearest Anritsu Service Center. If a passive antenna is in use, the message should display: Antenna OPEN Detected or Passive Antenna Used.

- **Receiver Status:** Current status of the receiver.

- **GPS Antenna Voltage and Current:** Shows voltage and current.

- **GPS Voltage:** Press this submenu key to set the source voltage at 3.3 V or 5 V, depending on the GPS receiver being used. The default setting is 3.3 V to prevent accidental damage to lower-voltage GPS antennas.

- **Reset:** The Reset key sets the number of tracked satellites to 0 and erases any almanac data and saved coordinates. The process of searching for and reacquiring satellites will begin again.

- **Back:** Press this submenu key to return to the “System Menu” on page 5-3.

---

**Figure 6-4. GPS Menu**
Chapter 7 — Bias Tee (Option 10)

7-1 Overview

Option 10 provides a bias tee that is installed inside the instrument. The bias arm is connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the voltage on the center conductor of the instrument’s RF In port. This supply of bias implies it is mostly useful when conducting two-port transmission measurements. This voltage can be used to provide power to block down converters in satellite receivers and can also be used to power some tower mounted amplifiers.

The bias can be turned on only when the instrument is in transmission measurement, channel scanner, interference analyzer, or spectrum analyzer mode. When bias is turned on, the bias voltage and current are displayed in the lower left corner of the display. The 12 VDC to 32 VDC power supply is designed to continuously deliver a maximum of 6 watts.

The bias tee menu can be accessed from the applications options menu and in transmission measurement, it can also be accessed from the Measure main menu.

Figure 7-1. Variable Bias Tee
Chapter 8 — Anritsu Tool Box

8-1 Introduction

The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu handheld RF instruments and a PC. The instrument connects to the computer via a USB, Ethernet, or serial port. Depending on the application selected, available functions range from the capture, transfer, and reporting of measurement data for trace analysis, to coverage and interference mapping, and the delivery of work instructions.

Tool Box applications are available for download from the Anritsu website at anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box. Click the link to one of the Tool Box applications, then click Downloads and choose either the Full Installer or Web Installer. There is no difference between the two if you run the installer without saving. If you elect to save, the Full Installer will download all Anritsu software needed in a single executable file, which allows you to perform the installation later on a computer with no Internet access required. The Web Installer is a much smaller file that will require Internet access to execute the software installation.

8-2 Software Installation

Whether running the installer directly or executing the saved file, follow the instructions on screen. The Setup screen illustrated in Figure 8-1 may change with the software version.

You will be asked to select which applications you wish to install. Not all instrument models are supported by every software tool. To view the list of instrument models supported by a Tool Box application, click the Instruments tab on the application Web page.

![Figure 8-1. Anritsu Tool Box Setup Wizard](anritsu-software-tool-box-v1.13.jpg)
The Anritsu Tool Box serves as a central location from which you can open a previously saved measurement, visit the Anritsu website, or launch an application. To open the Tool Box, either double-click the desktop shortcut or select Anritsu Tool Box from the Windows Start menu. On the Tool Box screen, hover the mouse pointer over any of the application icons to view a short description of the application. See Figure 8-2.
8-4 Software Tools

The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively, you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu Tool Box. For a detailed description of these features and how to perform specific tasks, refer to each application’s Help system. The program Help also lists the instrument models, measurement modes, trace types, and file types that are compatible with that application.

Line Sweep Tools (LST)

Line Sweep Tools is post-capture trace processing software designed for users who need to analyze and generate reports on large numbers of cable, antenna, and PIM traces. Software features include:

- Measurement plot data capture and transfer from the instrument to a PC
- Marker and limit line presets
- Return Loss, Distance-to-Fault, PIM analysis
- LMR Master and VNA Master Field Mode compatibility
- Plot overlay for comparison of up to ten traces of the same measurement type
- Plot area zooming
- A naming grid for renaming files, titles, and subtitles
- Automated report generation
- Output to printer or to PDF or HTML format
- Export of plot data to text, image, or VNA files

Master Software Tools (MST)

Master Software Tools is designed for users of Anritsu handheld spectrum analyzers, interference analysis tools, transmission testers, and backhaul testers. Supported functions include the following:

- Transfer of captured measurement data to and from a PC for storage and analysis
- RF Spectrum Analyzer traces
- RF Interference analysis
- Spectrum monitoring
- Transmitter signal quality tests
- T1, T3, and E1 backhaul tests
- Trace overlay features for comparing multiple Spectrum Analyzer measurements
- Limit lines and markers
- Script Master for the creation of automated test procedures
- Export of measurement data as text, graphic, or Comma Separated Value format (CSV) files
- Reports created in HTML format for use in other applications
easyTest Tools

easyTest Tools is used to create work instruction files that consist of a command sequence and instructions to help less experienced personnel with operating the instrument in the field.

- A drag-and-drop tool facilitates the creation of a test sequence from a library of commands.
- Instructions can be a mix of textual prompts and graphic images.
- Sample procedure files (.ett) are included with easyTest Tools.
- Command sequences are delivered electronically and loaded on the instrument, where they are recalled with a press of a button.
- Recall Setup places the instrument in the proper mode for the measurement by retrieving saved parameters such as measurement type, frequency and amplitude settings, markers and limit lines.
- The current measurement setup or the screen display can be saved manually or automatically.

easyMap Tools

easyMap Tools is the new name for Anritsu Map Master. The application allows users to find and prepare geo-referenced maps and to build floor plans suitable for Anritsu Handheld Spectrum Analyzers with Interference Analysis or Coverage Mapping capabilities (Option 25 or Option 431, respectively).

Software functions include:

- Creation of geo-referenced maps with pan and zoom capability
- Conversion of maps and floor plans to a form suitable for use on Anritsu Handheld Spectrum Analyzers and Interference Analyzers
- Introduction of GPS information into previously non-geo-referenced maps

Wireless Remote Tools

Wireless Remote Tools enables the user to remotely monitor and control the instrument over a wireless LAN connection.

- The wireless connection is typically established using a USB-powered Wi-Fi router attached to the instrument’s Ethernet port, and a matching Wi-Fi link on the PC end.
- Remote monitoring and control of the instrument enhance operator safety and efficiency when conditions make it unsafe or impractical to be close to the instrument.
Chapter 9 — Web Remote Control

9-1 Introduction

Web Remote Control capabilities are embedded in the Spectrum Master, providing full instrument control through an HTML-5 compatible browser. Ethernet connection is required. The ability to remotely monitor and control the instrument from the ground or desk enhances operator safety and efficiency when conditions make it unsafe or impractical to be close to the instrument. Login passwords can be used to allow access to authorized users only.

A remote connection terminates when the user logs out or closes the browser, or when the session time requested at login expires. To prevent multi-user conflicts, only one connection is permitted at a time. A second user who tries to log in will see a message indicating the instrument is currently reserved by another client, with the time remaining in their session.

While only one user can have control of the instrument, multiple users can view the same instrument using a desktop sharing application.

9-2 Setup

You can connect one or more instruments to any computer with HTML-5 compatible browser. Anritsu strongly recommends using Google Chrome, as other browsers do not fully support HTML-5. The control device may be a laptop, a desktop computer, or a mobile device, including a wide range of tablets and smart phones running Android or iOS operating systems. Note that you cannot download files to an iOS device, for lack of a user-accessible file system in this environment.

Physical connection is established from the instrument’s Ethernet port directly to the computer, or to a LAN or a Wi-Fi router such as the TP-Link TL-WR802N Wireless Router.

LAN Connection

1. Connect the Ethernet port of the Spectrum Master to your LAN.
2. Press Shift followed by System (8).
3. Press the Status submenu key to display the Status window and take note of the instrument IP address.
   Press Esc to close the Status window.
4. If no IP address has been assigned, refer to Appendix B, “LAN and DHCP” for information on setting an IP address for the instrument. If connecting to another network, we recommend that you request a static IP address from your network administrator to avoid duplicate addresses.
   Alternatively, you can set the instrument for dynamic IP addressing using DHCP. Refer to “Ethernet Menu” on page B-2. In a long distance network, however, it may be difficult or impossible to determine what the current dynamic address is, after the instrument is in the field.
5. Set instrument parameters as appropriate, such as measurement mode, frequency range, amplitude. You may skip this step and set up the instrument remotely at a later time, after Ethernet connection has been established.

6. Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to compatibility issues with HTML-5, do not connect using another browser than Chrome.

7. Enter the instrument IP address in the browser address bar to open the Web Remote Control Login page illustrated in Figure 9-1 on page 9-3.

Connection to a Wireless Router

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router. This section documents connection to a TP-Link TL-WR802N Wireless Router as an example.

1. Configure your Anritsu instrument with the following Ethernet settings:
   - IP Address = 192.168.0.50
   - Default Gateway Address = 0.0.0.0
   - Subnet Mask = 255.255.255.0
   Refer to “Ethernet Menu” on page B-2 for information on setting the IP address.

2. Using the Ethernet cable included with the router, connect one end to the LAN port and the other end to the test instrument’s Ethernet port.

3. Insert the micro-USB end of the provided cable into the router’s Power port and the Type-A end into one of the USB ports of your test instrument.

4. Connect your PC, laptop, or mobile device to the router via Wi-Fi, using the SSID and pre-programmed password that are printed on the router label. For example:
   - SSID = TP-LINK_39DE
   - Wireless password = 02850450

5. Launch the Google Chrome browser on your computer. Due to compatibility issues with HTML-5, do not connect using another browser than Chrome.

6. In the browser address bar, enter the instrument IP address set in Step 1 to open the Web Remote Control Login page illustrated in Figure 9-1 on page 9-3.

If you need to restore the router’s factory configuration:

1. Connect your PC, laptop, or mobile device to the router via Wi-Fi as described in Step 4 of the previous procedure.

2. In the Chrome browser, enter the URL address tplinkwifi.net. You can also log in using one of the router’s default IP addresses, 192.168.0.1 or 192.168.0.254.

3. Log in to the router using the default credentials:
   - username: admin
   - password: admin

4. Click Quick Setup.

5. Set the router as an Access Point and click Next until Quick Setup is completed.

6. Review the settings, then reboot the router using the on-screen Reboot button.

7. Enter the instrument IP address in the browser address bar to open the Web Remote Control Login page illustrated in Figure 9-1.
9-3  Web Remote Control Interface

The Web Remote Control Login page opens following browser connection to the instrument. See Figure 9-1. The page may show or hide certain elements depending on device management options set by the Administrator, as described in “Device Options” on page 9-11.

Figure 9-1. Login Page

User Login

To start a remote session with a test instrument:

1. Enter the instrument IP address in the Google Chrome address bar. The instrument must be connected via Ethernet as described in “Setup” on page 9-1.

2. Use the pull-down menus on the Login page to set the time, in hours and minutes, before the remote session times out. The default session time is 1 hour, with a 10-hour maximum.

   Only one user at a time can connect to the instrument. To avoid locking out other users unnecessarily, do not reserve a longer session than you need.

3. To enable functions available only to the network administrator, select the Login as Administrator checkbox.

4. Enter the instrument password, then click Login.

   The default administrator password is “Admin” with a capital A. The default password for other users is None; that is, leave the field blank.

If another user already has control of the instrument when you try to log in, a message will display indicating the instrument is currently reserved by another client, whose IP address is listed with the time remaining in their session.

Following login, the Web Remote Control Home page is displayed.
Home Page

The Web Remote Control Home page lists the same information as what is displayed on the instrument screen when you press **Shift, System (8)** at the front panel, followed by the **Status** menu key.

At the top of the page, a green banner shows the instrument model number and IP address. If the instrument has been assigned a name, this name is displayed in the center of the banner.

The menu bar below the banner consists of tabs for commands and links: Home, Remote Control, Capture Screen, Capture Trace, File List, Device Management, and Logout.

![Web Remote Control Home Page](image)

**Figure 9-2.** Web Remote Control Home Page
Remote Control

The Remote Control page displays a bitmap image of the instrument screen. The buttons on the right of the display reflect the layout of the buttons on the instrument and are used to access the same monitoring and control functions. See Figure 9-3.

---

**Notes**

- When clicking a key or measurement icon on the Remote Control page, a small green dot appears at the point of the cursor to indicate that the key, button, or icon was pressed.
- A single Web-enabled device can monitor and control multiple instruments. However, multiple Web-enabled devices with different IP addresses cannot connect to the same instrument simultaneously.

---

**Session Time Remaining**

This is the amount of time remaining before your remote session automatically terminates. The session time is reserved at login. It can be changed on the Device Management page.

---

**Normal Mode**

Normal Mode is the default mode, where the bitmap image of the instrument screen is continually refreshed in the browser window. Click the single arrow button near the bottom right of the page to return to Normal Mode from either Fast or Pause Mode. Clicking any tab on the menu bar also returns to Normal Mode.
Fast Mode
Click the double arrow button to enter Fast Mode, where the update rate can be significantly faster than Normal mode, especially over low bit-rate connections. Only the measurement data (yellow trace) is continually updated. The main menu keys and submenu keys may look different than in Normal Mode, but their functions are the same. Error messages are not shown in Fast Mode.

Fast Mode is not available with some Spectrum Analyzer measurement types, in which case the Fast Mode button is disabled. The button is not displayed when the measurement mode is something other than Spectrum Analyzer.

While in Fast mode, if a measurement type is selected that Fast mode does not support, the instrument will return to Normal mode.

Pause Mode
Clicking the Pause button turns the Communication Activity dot in the lower right-hand corner to yellow. If the interface was in Normal Mode, this stops the instrument display from refreshing in the browser window. If the interface was in Fast Mode, the trace measurement stops updating. Click the single arrow or the double arrow button to resume remote communications with the instrument in Normal or Fast Mode, respectively. The Communication Activity dot then returns to green.

Communication Activity
The moving dot labeled Communication Activity, when green, indicates that ongoing communication is occurring between the instrument and PC. When you click Home, Capture Screen, Capture Trace, File List, Device Management, or Logout on the menu bar, the Communication Activity dot briefly turns yellow before the selected page opens in the browser.

Configure Timeout
If the Ethernet connection is poor and you expect frequent lags in response time, you can increase the timeout up to 20 seconds, before the instrument sends an “Instrument Busy” message. The default timeout is 3 seconds.
Capture Screen

Captures a JPEG image of the current instrument display and saves it directly to internal memory. A file name is automatically created using the current date and time stamp. The captured display is loaded to the browser page, under the menu bar. See Figure 9-4. In Windows, you can right-click on the screen image and select Copy. With iOS, press and hold on the picture. This makes it easy to create documentation using screen captures.

![Figure 9-4. Capture Screen Page](image)

Capture Trace

Opens an input dialog to enter a name for the trace to be saved. See Figure 9-5. After clicking Save, a confirmation dialog opens to indicate the trace was successfully saved to the instrument.

![Figure 9-5. Capture Trace Page](image)

Depending on the browser and operating system used, different prompts may appear. Some operating systems like iOS may not support file saving from a browser.
File List
Displays the list of folders (type “dir”) and files contained in the instrument's internal memory. See Figure 9-6. To view the contents of a folder, click on the folder name.

![Figure 9-6. File List Page](image)

To download a file, click the file name. Alternatively, you can select the checkbox on the left of the file name, then click Download. You may also select the checkboxes of multiple files and/or folders and download them together, as a zipped folder. In this case, a pop-up dialog box shows the estimated download time. Press OK to continue.

**Note** Some operating systems, like iOS, do not support file downloads.

Depending on the browser and operating system, the download function may allow you to open the file or save it, or both. In Google Chrome, for example, the downloaded file or files are automatically saved to the designated folder on your computer, such as the Downloads folder. In the banner at the bottom of the browser window, click a downloaded item to open it.

If the selected item is a single file, the file will open in the default application for the file type. For example, a JPEG file will open in the computer’s default image viewer, while a measurement file will open in Master Software Tools (MST), provided the application is installed.

Device Management (not as Administrator)
Click the Device Management tab on the menu bar to set or clear the instrument password, to assign a device name to the instrument, or to change the session time. See Figure 9-7.

If you logged in as Administrator, the Device Management page has additional sections for viewing the remote access log and for setting device options. Refer to "Device Management (Administrator)” on page 9-10.

Password
If no password is set, which is the factory default, remote access to the instrument is unrestricted and any user who knows the instrument IP address can connect to it, provided the device isn’t currently reserved by another client. When a password is set, it is required upon login. To clear the current password, click the Reset button. This password is different from the administrator password described under “Device Management (Administrator)”. 
Instrument Name

The instrument name, if defined, is displayed in the green banner at the top of the page. It is useful in identifying the instrument when you have more than one instrument connected. The name can be assigned remotely from this Device Management page, or it can be set from the instrument's System Options menu. Note that this instrument name is not a "hostname" as used in an Ethernet router.

Session Time

Use the pull-down menus to select the time, in hours and minutes, before the remote session times out. Click Update to reset the session timer at the specified duration. At the end of the selected time period, a message notifying the user that the session has expired will display.
Device Management (Administrator)

Logging in as Administrator gives you access to additional functions associated with the instrument’s remote connection log and the display of information on the Login page.

![Device Management Page (Administrator)](image)

Figure 9-9. Device Management Page (Administrator)
Administrator Password

A password is always required to log in as Administrator. The password is case-sensitive, with “Admin” as the factory default. To change the password, type your new entry twice and click **Save**. See Figure 9-9 on page 9-10.

To restore the default password, click the **Reset** button. The administrator password is also reset to default each time you update the instrument firmware.

Access Log

The Access Log is viewable only when you are logged in as Administrator. It contains the date and time, success or failure status, and user information for up to 50 most recent login attempts. To save a copy of the log to the default download location on your control device, click **Download Log**. The saved file is a comma-delimited CSV file that can be opened with an application like Microsoft Excel. Click the **Clear Log** button to empty the Access Log.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some operating systems, such as iOS, do not support a user-accessible file system. Consequently, the download function is not possible if your control device is an Apple iPhone, for example.</td>
</tr>
</tbody>
</table>

Device Options

When logged in as Administrator, you have the option to turn on or off the optional text message and the green banner on the Login page.

For security reasons, for example, you may not want the instrument IP address to display during login. To hide the banner, deselect the **Show device banner on Login page** checkbox. See Figure 9-9 on page 9-10. After changing the Show/Hide setting, click **OK** in the Banner Visibility message box. You may need to scroll the browser page to bring the message box into view.

The factory default is to show the banner. Note that this device option only affects the Login page. Figure 9-10 illustrates the Login page with no banner.

![Figure 9-10. Login Page with Optional Text and No Banner](image-url)
To add a disclaimer or any other message to the Login page, enter the appropriate text in the text box under the Device Options section of the Device Management page, then click Save. See Figure 9-9 on page 9-10. Click OK in the update status message box (Figure 9-11). You may need to scroll the browser page to bring this message box into view.

![Figure 9-11. Disclaimer Text Update Status](image)

Figure 9-11. Disclaimer Text Update Status

Figure 9-10 on page 9-11 shows an example of optional text on the Login page. To remove the message, delete it from the Disclaimer Text box on the Device Management page and click Save, then OK.

**Instrument Name**

The instrument name function is the same whether you are logged in as Administrator or as a regular user. Refer to “Instrument Name” on page 9-9.

**Session Time**

The session time is set in the same manner, whether you are logged in as Administrator or as a regular user. Refer to “Session Time” on page 9-9.

**Logout**

Exits Web Remote Control and displays the Login page. To start a new session, enter the password if required, then select the session time and click Login.

| **Note** | If you close the Web Remote Control browser window without logging out, there may be a slight delay before the instrument is released. During this time, connection attempts by other users will fail. |

---

9-12  PN: 10580-00251  Rev. AC  MS2712E/13E User Guide
Appendix A — Measurement Guides

A-1 Introduction

This appendix provides a list of supplemental documentation for Spectrum Master features and options. These manuals are available as PDF files on the Anritsu website.

Table A-1. Analyzers and Analyzer Options (Sheet 1 of 3)

<table>
<thead>
<tr>
<th>Spectrum Master Feature (Required Option)</th>
<th>Related Document (Part Number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Site Master Instruments</td>
<td>Important Product Information, Compliance and Safety Notices (10100-00065)</td>
</tr>
<tr>
<td>Spectrum Analyzer</td>
<td></td>
</tr>
<tr>
<td>PIM Hunting</td>
<td></td>
</tr>
<tr>
<td>Interference Analyzer (Option 25)</td>
<td>Spectrum Analyzer Measurement Guide (10580-00349) for Firmware AFTER V1.11</td>
</tr>
<tr>
<td>Channel Scanner (Option 27)</td>
<td></td>
</tr>
<tr>
<td>Gated Sweep (Option 90)</td>
<td></td>
</tr>
<tr>
<td>Coverage Mapping (Option 431)</td>
<td></td>
</tr>
<tr>
<td>EMF Measurements (Option 444)</td>
<td></td>
</tr>
<tr>
<td>AM/FM/PM Analyzer (Option 509)</td>
<td></td>
</tr>
<tr>
<td>3GPP Signal Analyzer Measurement Guide</td>
<td></td>
</tr>
<tr>
<td>GSM/GPRS/EDGE Measurements (Option 880)</td>
<td></td>
</tr>
<tr>
<td>* GSM/EDGE RF Measurements (Option 40)</td>
<td></td>
</tr>
<tr>
<td>* GSM/EDGE Demodulation (Option 41)</td>
<td></td>
</tr>
<tr>
<td>W-CDMA/HSPA+ Measurements (Option 881)</td>
<td></td>
</tr>
<tr>
<td>* W-CDMA/HSPA+ RF Measurements (Option 44)</td>
<td></td>
</tr>
<tr>
<td>* W-CDMA/HSPA+ Demodulation (Option 65)</td>
<td></td>
</tr>
<tr>
<td>* W-CDMA/HSPA+ Over-the-Air Measurements (Option 35)</td>
<td>3GPP Signal Analyzer Measurement Guide (10580-00234)</td>
</tr>
<tr>
<td>TD-SCDMA/HSPA+ Measurements (Option 882)</td>
<td></td>
</tr>
<tr>
<td>* TD-SCDMA/HSPA+ Measurements (Option 60)</td>
<td></td>
</tr>
<tr>
<td>* TD-SCDMA/HSPA+ Demodulation (Option 61)</td>
<td></td>
</tr>
<tr>
<td>* TD-SCDMA/HSPA+ Over-the-Air Measurements (Option 38)</td>
<td></td>
</tr>
<tr>
<td>LTE/LTE-A FDD/TDD Measurements (Option 883)</td>
<td></td>
</tr>
<tr>
<td>LTE and TD-LTE Coverage Mapping (included)</td>
<td></td>
</tr>
<tr>
<td>TD-LTE/LTE OTA EMF Measurements (Option 444)</td>
<td></td>
</tr>
<tr>
<td>* LTE/LTE-A RF Measurements (Option 541)</td>
<td></td>
</tr>
<tr>
<td>* LTE/LTE-A Modulation Measurements (Option 542)</td>
<td></td>
</tr>
<tr>
<td>* LTE/LTE-A Over-the-Air Measurements (Option 546)</td>
<td></td>
</tr>
<tr>
<td>* TD-LTE/LTE-A RF Measurements (Option 551)</td>
<td></td>
</tr>
<tr>
<td>* TD-LTE/LTE-A Modulation Measurements (Option 552)</td>
<td></td>
</tr>
<tr>
<td>* TD-LTE/LTE-A Over-the-Air Measurements (Option 556)</td>
<td></td>
</tr>
<tr>
<td>LTE 256QAM Demodulation Measurements (Option 886)</td>
<td></td>
</tr>
<tr>
<td>NB-IoT Measurements (Option 887)</td>
<td></td>
</tr>
</tbody>
</table>
## Table A-1. Analyzers and Analyzer Options (Sheet 2 of 3)

<table>
<thead>
<tr>
<th>Spectrum Master Feature (Required Option)</th>
<th>Related Document (Part Number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3GPP2 Signal Analyzer Measurement Guide</td>
<td>3GPP2 Signal Analyzer Measurement Guide (10580-00235)</td>
</tr>
<tr>
<td>CDMA/EV-DO Measurements (Option 884)</td>
<td></td>
</tr>
<tr>
<td>* CDMA RF Measurements (Option 42)</td>
<td></td>
</tr>
<tr>
<td>* CDMA Demodulation (Option 43)</td>
<td></td>
</tr>
<tr>
<td>* CDMA Over-the-Air Measurements (Option 33)</td>
<td></td>
</tr>
<tr>
<td>* EV-DO RF Measurements (Option 62)</td>
<td></td>
</tr>
<tr>
<td>* EV-DO Demodulation (Option 63)</td>
<td></td>
</tr>
<tr>
<td>* EV-DO Over-the-Air Measurements (Option 34)</td>
<td></td>
</tr>
<tr>
<td>WiMAX Signal Analyzer Measurement Guide</td>
<td>WiMAX Signal Analyzer Measurement Guide (10580-00236)</td>
</tr>
<tr>
<td>WiMAX Fixed/Mobile Measurements (Option 885)</td>
<td></td>
</tr>
<tr>
<td>* Fixed WiMAX RF Measurements (Option 46)</td>
<td></td>
</tr>
<tr>
<td>* Fixed WiMAX Demodulation (Option 47)</td>
<td></td>
</tr>
<tr>
<td>* Mobile WiMAX RF Measurements (Option 66)</td>
<td></td>
</tr>
<tr>
<td>* Mobile WiMAX Demodulation (Option 67)</td>
<td></td>
</tr>
<tr>
<td>* Mobile WiMAX Over-the-Air Measurements (Option 37)</td>
<td></td>
</tr>
<tr>
<td>ISDB-T Digital Video Measurements (Option 30)</td>
<td>Digital Video Broadcast Signal Analyzer Measurement Guide (10580-00237)</td>
</tr>
<tr>
<td>ISDB-T SFN Measurements (Option 32)</td>
<td></td>
</tr>
<tr>
<td>ISDB-T BER Measurements (Option 79)</td>
<td></td>
</tr>
<tr>
<td>DVB-T/H Digital Video Measurements (Option 64)</td>
<td></td>
</tr>
<tr>
<td>DVB-T/H SFN Measurements (Option 78)</td>
<td></td>
</tr>
<tr>
<td>DVB-T/H BER Measurements (Option 57)</td>
<td></td>
</tr>
<tr>
<td>High-Accuracy Power Meter (Option 19)</td>
<td>Power Meter Measurement Guide (10580-00240)</td>
</tr>
<tr>
<td>Power Meter (Option 29)</td>
<td></td>
</tr>
<tr>
<td>Bias-Tee (Option 10)</td>
<td>2-Port Transmission Measurement Guide (10580-00242)</td>
</tr>
<tr>
<td>PIM Analyzer (Standard Feature)</td>
<td>PIM Master User Guide (10580-00280)</td>
</tr>
<tr>
<td>Tracking Generator (Option 20)</td>
<td>E-Series Tracking Generator Measurement Guide (10580-00339)</td>
</tr>
<tr>
<td>CPRI LTE RF Measurements (Option 752; requires Option 759)</td>
<td>CPRI LTE RF Analyzer Measurement Guide (10580-00415)</td>
</tr>
<tr>
<td>* Option 751 (obsolete) is functionally identical to the combined Options 752 and 759</td>
<td></td>
</tr>
<tr>
<td>Spectrum Master Feature (Required Option)</td>
<td>Related Document (Part Number)</td>
</tr>
<tr>
<td>-----------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>OBSAI LTE RF Measurements (Option 753; requires Option 759)</td>
<td>OBSAI LTE RF Analyzer Measurement Guide (10580-00434)</td>
</tr>
<tr>
<td>EMF Measurements (Option 444)</td>
<td>EMF Measurement Guide (10580-00455)</td>
</tr>
<tr>
<td>Performance Specifications</td>
<td>Spectrum Master Technical Data Sheet (11410-00511)</td>
</tr>
</tbody>
</table>

* Indicates the option is obsolete.

Appendix B — LAN and DHCP

B-1 Introduction

This appendix describes network connections for the MS2712E and MS2713E instrument models. Ethernet option is required for Rev 1 and Rev 2 models. Ethernet functionality is standard on Rev 3 models.

B-2 LAN Connection

The RJ-45 connector is used to connect the instrument to a local area network. Integrated into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to show that LAN traffic is present.

B-3 Ethernet Configuration

The instrument IP address is set by pressing the Shift key, then the System (8) key followed by the System Options submenu key and the Ethernet Config submenu key. The instrument Ethernet address can be set automatically using DHCP, or manually by entering the static IP address, gateway address, and subnet mask.

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the process of setting IP addresses for devices that use TCP/IP, and is a common method of configuring a device for network use.
Ethernet Menu

Key Sequence: **Shift, System** (8) > **System Options** > Ethernet Config

<table>
<thead>
<tr>
<th>Type</th>
<th>Manual</th>
<th>DHCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>IP</td>
<td>G-Way</td>
</tr>
<tr>
<td>First Octet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second Octet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Third Octet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fourth Octet</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Type**

**Manual DHCP:** Press the Type submenu key to select whether the IP address will be entered manually or will be supplied automatically by a network DHCP server. See Figure B-2 and Figure B-3 on page B-3.

If Manual is selected, use the submenu keys or the **Left/Right** arrow keys to select the field that is to be modified in the Ethernet Editor dialog. Use the numeric keypad, the **Up/Down** arrow keys, or the rotary knob to enter the values. Press **Enter** to accept the changes, or press the **Esc** key to exit Ethernet Configuration without making changes.

If DHCP is selected with the Type key, press **Enter** to close the Ethernet Editor dialog, then press **Shift, System**, and **Status** to view the IP address assigned by the DHCP server. Press **Esc** to close the Status screen.

**Field**

**IP G-Way Sub:** Press this submenu key to select the desired Internet Protocol Property to be edited.

**First Octet:** Moves the cursor to the leftmost column of the selected IP properties field.

**Second Octet:** Moves the cursor to the second column from the left of the selected IP properties field.

**Third Octet:** Moves the cursor to the third column from the left of the selected IP properties field.

**Fourth Octet:** Moves the cursor to the fourth column from the left of the selected IP properties field.

---

**Figure B-1.** Ethernet Menu
Figure B-2. Setting IP Address Manually

Figure B-3. IP Address Assigned Using DHCP
DHCP

DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to dynamically assign IP addresses to devices that are connected to the network. Most networks include a DHCP server to manage IP addresses.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic IP operation, the IP address in use may change from use to use. The DHCP server hands out IP addresses on a first come, first served basis. As soon as the device is disconnected from the network, the IP address that it was using becomes available to lease to the next unit that requests an IP address. Normally, some amount of lag time is present on the DHCP server end, so if the device is connected again reasonably soon, then it may end up with the same address.

When a DHCP server is not available, a static IP address can be used. A static IP address is a fixed address. After being set, it will always remain the same, and care must be taken to not conflict with other equipment on the network.

When using a static IP address on an established network, always request the static IP address from the network administrator. Randomly choosing a static IP address on an established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a static IP address:

**IP Address**

This is the static IP address on the network. Static IP addresses are necessary when you have no physical access to the instrument, or any other way to determine the instrument’s IP address assigned by the DHCP server.

**Default Gateway**

Often when a static IP address is assigned, a default gateway is also identified. If the default gateway is unknown, then type in the static IP address so that the static IP address and default gateway are the same number.

**Subnet Mask**

This parameter is usually extracted from the static IP address based on the class of the address and determines the destination of any broadcast messages that might be sent from the instrument. It can be customized if necessary. The subnet mask may also be provided with the static IP address.

**Example 1**

In this example, a static IP address has been chosen because no network DHCP service is available. The instrument is connected to the network port on the PC with an Ethernet cable. This is also referred to as Direct Connect:

- IP Address: 10.0.0.2
- Default Gateway: 10.0.0.2
- Subnet Mask: 255.255.0.0
Example 2
In this example, the static IP address has been assigned with an associated gateway and subnet mask:

- IP Address: 153.56.100.42
- Default Gateway: 153.56.100.1
- Subnet Mask: 255.255.252.0

B-4 ipconfig Tool

A few tools that are built into the Microsoft Windows operating system can assist in making some determinations about the network to which the PC is connected. Typing `ipconfig` at a command prompt produces a display of information about the in-use parameters of the PC and its network connection. Following is an example of the typical results expected:

```
Y:\>ipconfig
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix. : us.anritsu.com
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1
```

Note
The ipconfig display does not report whether the information is from a DHCP server or from a static IP setup.
Another tool that can find out if a selected IP address is already on the network is ping. Ping is a harmless way to determine if an address is found on the network, and (if it is found) to receive a reply. Basically, the ping function sends out a request to a specific address to determine if a computing device is connected to the network at that address. If a valid connection is found, then a copy of the signal (that was sent) is returned. If a connection is not found, then the response is “request timed out”, which means that no reply was received from that IP address.

```
Pinging 172.26.202.172 with 32 bytes of data:
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Ping statistics for 172.26.202.172:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:
Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
```
Appendix C — Glossary of Terms

C-1 Introduction

The following terms are related to this product and technology.

C-2 Glossary

3 dB rule: The 3 dB rule provides a means to estimate relative power values. A 3 dB gain indicates that power increases to twice the power (a multiple of 2). A 3 dB loss indicates that power decreases to half the power (a multiple of 1/2). A system with 40 watts of input power and a 6 dB insertion loss will have only 10 watts of output power (a multiple of 1/2 for each 3 dB loss, or 1/4 of 40 watts).

Adapter: A fitting that supplies a passage between two sets of equipment when they cannot be directly interconnected.

Adaptive Array Antenna: Adaptive array antenna is a type of advanced 'smart' antenna technology that continually monitors a received signal and dynamically adapts signal patterns to optimize wireless system performance. The arrays use signal processing algorithms to adapt to user movement, to changes in the radio-frequency environment, and to multi-path and co-channel interference.

ADC: Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device that converts continuous signals to discrete digital numbers. The reverse operation is performed by a digital-to-analog converter (DAC). ADC can uniquely represent all analog input values within a specified total input range by a limited number of digital output codes. Refer also to DAC.

Analog System: An Analog system uses an analog transmission method to send voice, video and data using analog signals, such as electricity or sound waves, that are continuously variable rather than discreet units as in digital transmissions. Mobile analog systems include AMPS, NMT and ETACS.

Analog Transmission: Analog Transmission refers to signals propagated through the medium as continuously varying electromagnetic waves.
Antenna: Antenna is a device which radiates and/or receives radio signals, including RF, microwave, and RADAR.

Antenna beamwidth: Antenna beamwidth, also known as the half-power beamwidth, is the angle of an antenna pattern or beam over which the relative power is at or above 50% of the peak power.

Antenna Directivity: Antenna directivity, also known as antenna gain, is the relative gain of the main beam of an antenna pattern to a reference antenna, usually an isotropic or standard dipole. Antenna Directivity is the percentage of radiated signal transmitted or received in a given direction related to beamwidth.

Antenna Efficiency: Antenna Efficiency is the percentage of theoretical gain actually realized from an antenna.

Antenna Gain: Antenna gain, also known as antenna directivity, is the relative gain of the main beam of an antenna pattern to a reference antenna, usually an isotropic or standard dipole. Antenna Gain is the effectiveness of a directional antenna expressed as the ratio of input power of the directional antenna to input power of an isotropic radiator to provide the same field strength in the desired direction. Sometimes related to a dipole antenna.

Antenna, Isotropic: An isotropic antenna is a theoretical point source radiating a spherical power envelope.

Antenna, Parabolic: A parabolic antenna is an antenna utilizing a reflector that is shaped as a paraboloid in order to both concentrate the radiated signal into a beam and to provide considerable gain. Beamwidth varies inversely and gain varies directly with the size of the antenna and with frequency.

Attenuation: Attenuation refers to decreasing in signal magnitude between two points. These points may be along a radio path, transmission line or other devices.

Attenuator: Attenuator is a device specifically designed to decrease the magnitude of a signal transmitted through it.
Average power: Average power is the peak power averaged over time and is usually applied to pulsed systems where the carrier power is switched on and off.

Backhaul: In wireless technology, backhaul refers to transporting voice and data traffic from a cell site to the switch.

Band Pass Filter: A Band Pass Filter is a radio wave filter with a specific range of frequencies in which it is designed to pass. It rejects frequencies outside the pass-band range. A resistor-inductor-capacitor circuit is an example of a Band Pass Filter.

Bandwidth: Bandwidth usually identifies the capacity of a circuit or amount of data that can be sent through a given circuit. It may be user-specified in a PVC. It is an indication of the amount of data that is passing over a medium. Also, bandwidth is the portion of the frequency spectrum required to transmit desired information. Each radio channel has a center frequency and additional frequencies above and below this carrier frequency which is used to carry the transmitted information. The range of frequencies from the lowest to the highest used is called the bandwidth.

BER: Bit Error Rate or Bit Error Ratio (link quality specification/testing) (BER) is a measure of transmission quality. The ratio of error bits to the total number of bits transmitted. A bit error rate of 10^-6 refers to an average of one error per million bits. It is generally shown as a negative exponent, (for example, 10^-7 which means 1 out of 107 bits are in error or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of a sequence of message bits that are in error.

BERT: Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of the T1 or digital line. By sending a known pattern to another device across the span, the far end device can compare incoming pattern to its own, thereby indicating bit errors on the line.

Broadband: Broadband refers to telecommunication that provides multiple channels of data over a single communications medium, typically using some form of frequency or wave division multiplexing. It is a service or system requiring transmission channels capable of supporting rates greater than the Integrated Services Digital Network (ISDN) primary rate.
**Cell Site:** Cell Site, also called Base Station, is the local cellular tower and radio antenna (including the radios, controller, switch interconnect, etc.) that handles communication with subscribers in a particular area or cell. A cellular network is made up of many cell sites, all connected back to the switch via landline or microwave.

**Coaxial Cable:** Coaxial Cable (Coax) is a type of electrical communications medium used in the LAN environment. This cable consists of an outer conductor concentric to an inner conductor, separated from each other by insulating material, and covered by some protective outer material. This medium offers large bandwidth, supporting high data rates with high immunity to electrical interference and a low incidence of errors. Coax is subject to distance limitations and is relatively expensive and difficult to install.

**CPRI:** The Common Public Radio Interface (CPRI) is a protocol standard for wireless communications that defines the digital interface of radio base stations between remote radio heads, also referred to as Radio Equipment (RE), and the Radio Equipment Controller (REC).

**CW:** Continuous Wave (CW)

**DANL:** Displayed Average Noise Level (DANL): Displayed average noise level is sometimes confused with the term Sensitivity. While related, these terms have different meanings. Sensitivity is a measure of the minimum signal level that yields a defined signal-to-noise ratio (SNR) or bit error rate (BER). It is a common metric of radio receiver performance. Spectrum analyzer specifications are always given in terms of the DANL. One of the primary uses of a spectrum analyzer is to search out and measure low-level signals. The limitation in these measurements is the noise generated within the spectrum analyzer itself. This noise, generated by the random electron motion in various circuit elements, is amplified by multiple gain stages in the analyzer and appears on the display as a noise signal. On a spectrum analyzer, this noise is commonly referred to as the Displayed Average Noise Level, or DANL 1. While there are techniques to measure signals slightly below the DANL, this noise power ultimately limits our ability to make measurements of low-level signals.
**dB**: Decibel or deciBel (dB) is a logarithmic ratio of the difference between two values (a logarithm ratio is equal to 10 times). dB is a unit for measuring relative power ratios in terms of gain or loss. The units of dB are expressed in terms of the logarithm to base 10 of a ratio and typically are expressed in watts. For example, a -3 dB loss indicates a 50% loss in power; a +3 dB reading is a doubling of power; 10 dB indicates an increase (or a loss) by a factor of 10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB = 1:1, 10 dB = 10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or (1/1000):1].

**dBc**: Decibels referenced to the carrier (dBc) is a technique for expressing a power measurement in logarithmic form using the carrier power as a reference. The units are used to describe how far down signals and noise are relative to a known signal. Typical use of this term is to describe spurious signals and noise compared to a desired transmit signal.

**dBm**: dBm is an absolute measurement of power relative to 1 milliWatt. In other words, dBm is a decibel value referenced to a milliWatt (dBm). This is a technique for expressing a power measurement in logarithmic form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts (W) to one milliWatt (1mW). dBm, therefore, represents absolute power. Examples are: 0 dBm = 1.0 milliWatt, 10 dBm = 10 milliWatt, 30 dBm = 1000 milliWatt = 1 watt.

**DHCP**: Dynamic Host Configuration Protocol (DHCP)

**DSP**: Digital Signal Processing (DSP)

**EMI**: ElectroMagnetic Interface (EMI): EMI refers to signals that are generated and radiated by an electronic device and that cause interference with radio communications, among other effects. MI is the interference by electromagnetic signals that can cause reduced data integrity and increased error rates on transmission channels.

**FFT**: Fast Fourier Transform (FFT) is an efficient algorithm to compute the Discrete Fourier transform (DFT) and its inverse. FFTs are of great importance to a wide variety of applications, from digital signal processing to solving partial differential equations to algorithms for quickly multiplying large integers.
**Flash Memory**: Flash memory is a non-volatile solid state storage device that is packaged as a chip. It can be electrically erased and reprogrammed. It is primarily used in memory cards, USB flash drives, MP3 players, and solid-state drives for general storage and transfer of data between computers and other digital products. It is a specific type of EEPROM (electrically erasable programmable read-only memory) that is erased and programmed in large blocks.

**Gain**: Gain refers to the ratio of the output amplitude of a signal to the input amplitude of the signal. This ratio typically is expressed in dB. The higher the gain, the better the antenna receives or transmits, but also the more noise it includes.

**GPS**: The Global Positioning System (GPS) is a space-based global navigation satellite system (GNSS) that provides reliable location and time information in all weather and at all times when and where an unobstructed line of sight is available to four or more GPS satellites. The system is maintained by the United States government and is freely accessible by anyone with a GPS receiver. The Global Positioning System is making it possible for people using ground receivers to determine their geographic location within 10 meters to 100 meters. The satellites use simple mathematical calculations to broadcast information that is translated as longitude, latitude, and altitude by Earth-based receivers.

**Impedance**: Impedance is a measure of RF component electrical resistance, measured in ohms. In most cable and antenna systems, the standard impedance is 50 ohms.

**Insertion Loss**: Insertion Loss (or Cable Loss) is a measure of the total amount of signal energy absorbed (lost) by the cable assembly. It is measured in dB. S21 (an S-Parameter) is another name for this measurement.

**IP Address**: An Internet Protocol address (IP address) is usually a numerical label that is assigned to each device (computer or printer for example) that is participating in a computer network that uses the Internet Protocol for communication. An IP address serves two main functions: location addressing and host (or network) interface identification. The Internet Protocol originally defined an IP address as a 32-bit number. This was known as Internet Protocol Version 4 (IPv4), which is still in use. Growth of the Internet requires a new addressing system. An Internet Protocol Version 6 (IPv6) that uses 128 bits for the address was developed in 1995, and it is standardized as RFC 2460. IPv6 began being deployed worldwide in the year 2000. IP addresses are binary...
numbers, but they are usually stored in text files and displayed in human-readable notations, such as decimal nnn.nnn.nnn.nnn or 172.16.255.1 (for IPv4), and hexadecimal nnn.nnn.nnn.nnn.nnn.nnn.nnn.nnn or 2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal group (nnn) represents values from 000 to 255, or binary values of 8 bits. In IPv6, each hexadecimal group (nnnn) represents values from 0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111).

**IPv6**: Internet Protocol Version 6 (IPv6) is a numerical label that is used to identify a network interface of a computer or other network node participating in an IPv6-enabled computer network. IPv6 uses 128 bits for the address (as compared to an IPv4 address, which is defined as a 32-bit number). IPv6 was developed in 1995, and it is standardized as RFC 2460. V6 began being deployed worldwide in the year 2000. IPv6 addresses are binary numbers, but they are usually stored in text files and displayed in human-readable notations, such as hexadecimal nnn.nnn.nnn.nnn.nnn.nnn.nnn.nnn or 2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). Each hexadecimal group (nnnn) represents values from 0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111).

**NF**: Noise Figure (NF) is a measure of degradation of the signal-to-noise ratio (SNR) that is caused by components in a radio frequency (RF) device. The noise factor (F) of a system is defined as the signal-to-noise ratio of the input power of the system divided by the signal-to-noise ratio of the output power of that system. F (the noise figure) is defined as the decibel value of the noise factor. NF = 10log (F) where log uses the base 10, or common log. This formula is valid only then the input termination is at standard noise temperature.

**OBSAI**: The Open Base Station Architecture Initiative (OBSAI) specifications define a set of requirements for a wireless base transceiver station (BTS). Reference Point 3 (RP3) within the OBSAI specifications defines the digital interface between the Base Band Module (BBM) and the Radio Frequency Module (RFM). This is an alternative to the traditional Radio Frequency (RF) coaxial connection, or the CPRI digital interface.

**OBW**: Occupied Bandwidth (OBW) is a measure of the bandwidth containing 99% of the total integrated power of the transmitted spectrum, centered on the assigned channel frequency. Interference to other channels or to other systems can occur if OBW is too large.
OTA: Over The Air (OTA): OTA refers generally to any transfer of information or signal that takes place in a wireless environment, rather than using a wired connection. OTA is usually used in connection with a standard defining the provisioning of mobile devices and applications, such as downloading or uploading content or software, and commonly used in conjunction with the Short Messaging Service (SMS). SMS OTA Messages contain information that is used to configure the settings of a WAP browser in a mobile phone (refer to SMS and WAP).

Return Loss: Return Loss is a measurement (in dB) of reflected energy caused by impedance mismatch. May also be referred to as S11. Although S11 values are expressed as negative numbers, Return Loss values are expressed as positive numbers because by definition the \( \text{iLoss} \) expression implies a negative sign. The higher the value, the better the impedance match (think of a large negative number being less than a smaller negative number). 40 dB is nearly ideal. Only 0.01% of the total transmitted power is reflected if the Return Loss measurement value is 40 dB. A measured value of 0 dB would be a complete reflection, or stated another way, 100% of the transmitted power is reflected back. Return Loss is typically a pass/fail measurement.

RF: Radio Frequency (RF) is the frequency of radio sine waves. RF generally refers to wireless communications within a frequency range of 3 kHz to 300 GHz. Formally, according to the Article 2 of the Radio Law, radio frequency is below 3,000 GHz. Radio frequencies can be used for communications between a mobile telephone and an antenna mast.

SCPI: Standard Commands for Programmable Instruments (SCPI)

Watt: Watt (W) is a unit of measure for power.
## Index

### A
- access log .................................. 9-11
- additional documents .................. A-1
- address, Ethernet IP address ........ B-1
- administrator
  - login ...................................... 9-3
  - password .................................. 9-3
- annual verification ......................... 1-5
- Anritsu
  - contacting ................................ 1-3
- Tool Box .................................. 8-1, 8-2
- antenna
  - GPS antenna location ................... 6-2
- application self test ..................... 5-10
- arrow navigation
  - saving a measurement .................. 2-11
- auto dim .................................. 5-8

### B
- banner
  - show/hide ................................ 9-11
- battery
  - charging .................................. 1-8
  - replacement ................................ 1-8
  - symbol .................................... 2-7, 2-8
- bias tee .................................... 7-1
- black on white ................................ 5-7
- black plug body ................................ 2-8
- brightness .................................. 5-7, 5-8
  - settings menu ................................ 5-8

### C
- calibration
  - touch screen ................................ 2-10, 5-3
- camera icon ................................ 2-8
- capture
  - screen .................................... 2-8, 9-7
  - trace ..................................... 9-7
- carrying case ................................ 2-18
- caution
  - adapter, auto cigarette lighter ...... 1-9, 2-1
  - air flow through Spectrum Master .................. 2-19
  - approved batteries and chargers .... 2-7
  - language and custom settings .......... 5-4
  - center frequency sharing ................ 5-5
  - change directory ......................... 4-10
  - charging battery symbol ................ 2-7, 2-8
- color on white .............................. 5-7
- community activity ......................... 9-6
- connection
  - LAN ......................................... 9-1
  - router ..................................... 9-2
- connector panel .............................. 2-15
- contacting Anritsu ........................... 1-3
- copy menu .................................. 4-14
- create folder ................................ 4-11
- custom language
  - settings lost with reset ................ 5-4

### D
- date and time key .......................... 5-4
- default
  - display colors .............................. 5-7
  - factory defaults ........................... 5-9
  - gateway, for IP address .................. B-4
- DHCP
  - LAN connection ............................ B-1
  - more information .......................... B-4
- disclaimer text .............................. 9-12
- disk storage icon, floppy .................. 2-8
- display
  - auto dim .................................. 5-8
  - brightness .................................. 5-8
  - color schemes ................................ 2-9, 5-7
  - settings .................................... 2-9, 5-7
  - turn off .................................... 5-7
- display key .................................. 5-4

Dynamic Host Configuration Protocol
  see DHCP

### E
- easyMap Tools ................................ 8-4
- easyTest Tools ................................ 8-4
- electrostatic discharge .................... 1-7
- entering data ................................ 2-12
- ESD. See electrostatic discharge
- Ethernet
  - configuration ............................. 5-4, B-1
  - IP address ................................ B-1
  - menu ........................................ B-2
- external
  - power control .............................. 3-8, 5-6
  - reference port ................................ 2-15
- external power ................................ 2-16
F
factory defaults ........................................ 5-9
custom language settings lost .......................... 5-4
fast mode .............................................. 9-6
file
management ........................................ 4-1
menu ................................................ 4-9
name .............................................. 4-3
types ............................................... 4-1
firmware
update .............................................. 5-11
updating key ........................................ 5-9
floppy disk storage icon ............................... 2-8
frequency
external reference port .............................. 2-15
frequency range .................................. 1-4
G
gateway
default, for IP address .............................. B-4
part of IP address ................................ B-1
GPS .................................................. 6-1
icon, green ........................................ 2-8
icon, red ........................................... 2-8
menu ................................................ 6-4
H
high contrast ............................................ 5-7
I
icon
battery symbol ........................................ 2-7, 2-8
camera ............................................... 2-8
GPS .................................................. 2-8
red plug body ....................................... 2-8
shift key ........................................... 2-8
storage, floppy disk ................................ 2-8
instrument name ................................... 5-4, 9-9
internal memory ................................... 1-3
IP address ........................................ 9-1, B-1
default gateway .................................... B-4
ping tool .......................................... B-6
static ............................................... B-4
subnet mask ....................................... B-4
ipconfig tool ...................................... B-5
J
JPEG image icon ..................................... 2-8
LAN and DHCP information ......................... B-1
LAN connection ................................. 2-17, 9-1
language
custom settings lost with reset .................... 5-4
key for display .................................. 5-4
LED
battery is charging ............................... 2-8
power to instrument ............................. 2-8
Line Sweep Tools .................................. 8-3
links
contacting Anritsu ................................ 1-3
login ............................................. 9-3, 9-11
logout .............................................. 9-12
LST. See Line Sweep Tools
M
maintenance .......................................... 1-6
mask, subnet, for IP address ....................... B-4
master reset
custom language settings lost ..................... 5-4
master reset key .................................. 5-9
Master Software Tools .............................. 8-3
measurement guides ................................ A-1
measurements
saving in arrow navigation ...................... 2-11
menu
copy ............................................. 4-14
delete ............................................. 4-15
display settings ................................ 5-7
Ethernet .......................................... B-2
file ............................................... 4-9
file type .......................................... 4-11
GPS .............................................. 6-4
mode selector ..................................... 2-14
Power-On ......................................... 5-6
preset ............................................. 5-10
recall ............................................. 4-13
reset .............................................. 5-9
save .............................................. 4-10
save location .................................... 4-11
save on event .................................... 4-12
system ........................................... 5-2, 5-3
system options .................................. 5-4
system options 2/2 .............................. 5-5
mode selector ..................................... 2-14
MST. See Master Software Tools
N
name. See instrument name
night vision ....................................... 5-7
normal mode ....................................... 9-5
O
on/off button .......................... 2-8
optical transceiver port .............. 2-17

P
password
  remote .................. 5-5, 9-3, 9-8, 9-11
pause mode ..................... 9-6
ping tool ...................... B-6
plug body
  black icon .................. 2-8
plug body, red icon .............. 2-8
power button .................... 2-8
power offset sharing ............ 5-5
power supply ................... 2-1
power-on menu .................. 5-6
preset menu .................... 5-10

Q
quick name ...................... 4-3

R
recall menu ..................... 4-12, 4-13
refresh directories .............. 4-11, 4-13, 4-14, 4-15
remote
  access log ................... 9-11
  control display .............. 9-5
device management .............. 9-8, 9-10
device options ................ 9-11
instrument name ................ 5-4, 9-9
interface ........................ 9-3
password ...................... 5-5, 9-3, 9-8, 9-11
session time .................. 9-3, 9-5, 9-9
Web control .................... 9-1
reset settings .................. 5-9

S
save
  measurement, in arrow navigation 2-11
  menu .......................... 4-10
screen capture images ........... 2-8
self test ........................ 5-3, 5-10
session time .................. 9-3, 9-5, 9-9
SFP port ......................... 2-17
share center freq and power offset key 2-17
Software Tool Box .............. 8-1, 8-2
static IP address
  setting parameters .......... 8-4
storage icon ................... 2-8
subnet .......................... B-1
subnet mask, for IP address ...... B-4
system
  display settings .......... 2-9, 5-7
  menu ......................... 5-2, 5-3
  options menu .............. 5-4
  self test .................... 5-10
  system options 2/2 menu . 5-5

T
tilt bail ...................... 2-19
Tool Box ....................... 8-1, 8-2
touch screen
  calibration .................. 2-10, 5-3
  keys ........................ 2-6

U
update firmware ................ 5-11
USB
  update firmware .............. 5-11
USB connectors ................. 2-16

V
volume key ..................... 5-4

W
warning
  AC-DC adapter use ............ 2-16
Web remote control ............. 9-1
website, contacting Anritsu .... 1-3
Wireless Remote Tools .......... 8-4
wireless router ................. 9-2